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Preface

This guide describes how to install and configure Oracle Utilities Analytics, including:

• Audience

• Prerequisite Knowledge

• Related Documents

• Conventions

• Acronyms

Audience
This guide is intended for anyone interested in the process of installing, upgrading, or configuring 
Oracle Utilities Analytics.

Prerequisite Knowledge
Oracle Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards use several 
technologies. You should have knowledge of the following before configuring and administering 
Oracle Utilities Analytics:

• Oracle Data Warehouse:

http://docs.oracle.com/cd/E11882_01/server.112/e25554/toc.htm

• Oracle Data Integrator:

http://docs.oracle.com/cd/E28280_01/nav/odi.htm

• Oracle GoldenGate:

http://docs.oracle.com/goldengate/1212/gg-winux/index.html

• Oracle WebLogic Server:

http://docs.oracle.com/cd/E23943_01/nav/wls.htm

• Oracle Business Intelligence Enterprise Edition:

http://docs.oracle.com/cd/E28280_01/nav/bi.htm
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Related Documents
For more information, refer to the following documents in the Oracle Utilities Analytics 
documentation library:

• Oracle Utilities Analytics Getting Started Guide

• Oracle Utilities Analytics License Information User Guide

• Oracle Utilities Analytics Administration Guide

• Oracle Utilities Analytics Quick Install Guide

• Oracle Utilities Analytics Developer’s Guide

• Oracle Utilities Analytics Release Notes

• Oracle Utilities Analytics Dashboards for Oracle Utilities Meter Data Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Customer Analytics, Revenue Analytics, and 
Credit & Collections Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Exception Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Mobile Workforce Analytics Metric Reference 
Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Distribution Analytics and Outage Analytics 
Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Work and Asset Analytics Metric Reference 
Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Operational Device Analytics Metric Reference 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Customer Care and Billing Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Meter Data Management Data Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Mobile Workforce Management Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Network Management System Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Operational Device Management Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Work & Asset Management Data Mapping 
Guide
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Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

Acronyms
The list of acronyms used in this guide is as explained below: 

• APEX: Oracle Application Express

• CC&B: Oracle Utilities Customer Care and Billing

• CDC: Changed Data Capture 

• ELT: Extraction, Loading and Transformation

• ETL: Extraction, Transformation, and Loading

• MDM: Oracle Utilities Meter Data Management

• MWM: Oracle Utilities Mobile Workforce Management

• NMS: Oracle Utilities Network Management System

• OBIEE: Oracle Business Intelligence Enterprise Edition

• ODI: Oracle Data Integrator

• ODM: Oracle Utilities Operational Device Management

• OGG: Oracle GoldenGate

• OUA: Oracle Utilities Analytics

• WAM: Oracle Utilities Work and Asset Management
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Chapter 1 
 Introduction 

This chapter provides an overview of the installation of Oracle Utilities Analytics. This includes: 

• About Oracle Utilities Analytics Installation

• Installation Components

• Installation Types

About Oracle Utilities Analytics Installation
The installation of Oracle Utilities Analytics v2.5.2.0.1 is a full installation of Oracle Utilities 
Analytics product. This means that you do not need to install any previous version Oracle Utilities 
Analytics before installing Oracle Utilities Analytics v2.5.2.0.1.

Installation Components
Oracle Utilities Analytics (OUA) installation consists of the following components, each of which 
needs to be installed for a successful installation:

• Oracle Utilities Analytics Database component containing star schemas and product 
metadata

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator (ODI) containing 
pre-built Oracle Data Integrator objects necessary for the ELT processes.

Note: Oracle GoldenGate (OGG) is utilized to capture the data and this is 
required for Oracle Data Integrator based ELT.

• Oracle Utilities Analytics Administration Tool component is an Oracle Application Express 
application used to maintain several Oracle Utilities Analytics configuration parameters.

• Oracle Utilities Analytics Dashboard component contains the pre-built Oracle Business 
Intelligence Enterprise Edition Web Catalog, RPD file and answers based on Oracle Business 
Intelligence Enterprise Edition.

Note: Oracle Utilities Analytics Dashboard component should be installed on 
the server where Oracle Business Intelligence Enterprise Edition is installed.

Oracle Utilities Analytics Dashboards also include the demo database with the 
pre-populated data that can be used for training or demonstration purposes. 
Refer to the Chapter 5: Installing Demo Database for steps involved in 
installing each of the required components. 

Note: See the section Prerequisite Software of the Chapter 2: Preparing for 
Installation for the list of prerequisite software necessary for installing each 
component.
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Installation Types
The first step in the installation procedure is to determine the installation type. The following are 
the possible installation types:

• Initial Installation, an installation from scratch.

• Upgrade, an upgrade from an earlier version to Oracle Utilities Analytics v2.5.2.0.1.

• Demo Installation, an installation with pre-populated demo data.

Initial Installation
This installation type is applicable when installing Oracle Utilities Analytics for the first time, or 
from scratch. The prerequisite software for each of the component should be installed prior to 
installing the component. Each of the following components should be installed during an initial 
installation: 

• Oracle Utilities Analytics Database component.

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator 

• Oracle Utilities Analytics Dashboard component

• Oracle Utilities Analytics Administration Tool component

Note: Refer to the Chapter 3: Oracle Utilities Analytics Initial Installation for 
the steps involved in installing each of the above-mentioned components.
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The following diagram shows the workflow for the initial installation process:
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Upgrade
This installation type is applicable when upgrading to Oracle Utilities Analytics v2.5.2.0.1 from an 
earlier version. The prerequisite software may need to be upgraded before upgrading the Oracle 
Utilities Analytics components.

Note: Refer to the section Supported Upgrade Paths of the Chapter 4: 
Upgrading Oracle Utilities Analytics to find out how upgrade of your particular 
version is supported.

Note: Refer to the Chapter 4: Upgrading Oracle Utilities Analytics for the steps 
involved in upgrading each of the required components.

Each of the following components should be upgraded during an upgrade process:

• Oracle Utilities Analytics Database component.

• Oracle Utilities Analytics ELT component based on Oracle Data Integrator 

• Oracle Utilities Analytics Dashboard component

• Oracle Utilities Analytics Administration Tool component

The following diagram shows the workflow for the upgrade process:
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Demo Installation
This installation type is applicable when installing the demo database component of Oracle 
Utilities Analytics Dashboards for demonstration, or training purposes. The following 
components should be installed for a demo installation:

• Oracle Utilities Analytics Demo Database component

• Oracle Utilities Analytics Dashboard components

Note: Refer to the Chapter 5: Installing Demo Database for the steps involved 
in installing each of the required components.

The following diagram shows the workflow for the demo installation process:
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Chapter 2 
Preparing for Installation

This chapter provides information about planning Oracle Utilities Analytics (OUA) installation 
v2.5.2.0.1, including:

• Installation Checklist

• Prerequisite Software

• Deployment

• Operating Systems and Application Servers

• Supported Source Application Versions

• Additional Notes on the Supported Platforms

Note: In order to perform successful installation of the product, you must have 
experience of working on, or installing the following products:

• Oracle Database Server

• Oracle Business Intelligence Enterprise Edition

• Oracle Data Integrator

• Oracle GoldenGate

• Oracle Application Express feature of Oracle database

Note: Refer to the corresponding installation guide of these products before 
installing Oracle Utilities Analytics.
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Installation Checklist
The following checklist guides you through the installation process for Oracle Utilities Analytics 
v2.5.2.0.1:

The details are provided in subsequent chapters for each of the below-listed step: 

1. Determine the installation type. See Installation Types to determine the installation type for 
your scenario. Perform the installation steps as applicable to your installation type.

2. Install the prerequisite software. 
See Prerequisite Software for more details.

3. Ensure that you have downloaded the required Oracle Utilities Analytics components.

Note: Refer to the Chapter 3: Oracle Utilities Analytics Initial Installation for 
instructions regarding initial installation.

Note: For upgrading from an earlier version of Oracle Utilities Analytics to 
Oracle Utilities Analytics v2.5.2.0.1, refer to the Chapter 4: Upgrading Oracle 
Utilities Analytics.

Note: Refer to Chapter 5: Installing Demo Database for instructions about 
demo installation. 

4. Configure the application. 

Prerequisite Software
For installing Oracle Utilities Analytics v2.5.2.0.1, a few prerequisite software products need to be 
downloaded and installed. Download and install these software products as per the instructions 
provided in the respective installation documents.

Note: Ensure that the same Operating System (OS) user is used to install all 
software prerequisites and Oracle Utilities Analytics components.

The following sections describe the prerequisite software requirement Oracle Utilities Analytics:

• Prerequisite Software for Oracle Utilities Analytics Database Component

• Prerequisite Software for Oracle Utilities Analytics Installer

• Prerequisite Software for Oracle Data Integrator Based ELT Component

• Prerequisite Software for Oracle Utilities Analytics Administration Tool Component

• Prerequisite Software for Oracle Utilities Analytics Dashboards Component

Prerequisite Software for Oracle Utilities Analytics Database Component
The prerequisite software for Oracle Utilities Analytics database component is as described below:

• Oracle Database Server Enterprise Edition 12.1.0.2.0

Note: Oracle Utilities Analytics v2.5.2.0.1 is supported on Oracle 
Database Server Standard Edition 12.1.0.1.0 when using ELT component 
based on Oracle Data Integrator.

Prerequisite Software for Oracle Utilities Analytics Installer
The prerequisite software for Oracle Utilities Analytics Installer is as described below:

• JDK 1.7
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Prerequisite Software for Oracle Data Integrator Based ELT Component
The prerequisite software products for Oracle Utilities Analytics ELT component based on Oracle 
Data Integrator (ODI) are listed below:

•  JDK 1.6.0 (35)

• Oracle Database Server Enterprise Edition 12.1.0.2.0, or Oracle Database Server Standard 
Edition 12.1.0.1.0

• Oracle WebLogic 10.3.6

• Oracle Data Integrator 11.1.1.7 with Java EE

• Oracle GoldenGate on the source application database server and the target database server.
This can be downloaded from Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com).

• Oracle Utilities Analytics Administration Tool

Note: Oracle Utilities Analytics Database Component must be installed before 
the installation of Oracle Utilities Analytics ELT Component Based on Oracle 
Data Integrator.

Prerequisite Software for Oracle Utilities Analytics Administration Tool 
Component

Note: Applicable only if you use Oracle Data Integrator based ELT.

The prerequisite software products for the Oracle Utilities Analytics Administration Tool 
component are as follows:

• Oracle Database Server Enterprise Edition 12.1.0.2.0 or Oracle Database Server Standard 
Edition 12.1.0.1.0

• Oracle REST Data Services 3.0

• Oracle Apex 4.2.6

Prerequisite Software for Oracle Utilities Analytics Dashboards Component
The prerequisite software for Oracle Utilities Analytics Dashboard component is as follows:

• Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 (Install Oracle Business 
Intelligence Enterprise Edition 11.1.1.7.0 and apply the patch 18818588) with the 
Enterprise Install option.

Note: Install the Oracle 12.1.0.2.0 client if Oracle Business Intelligence 
Enterprise Edition software is not installed on the database server. If 
Oracle Business Intelligence Enterprise Edition software is installed, 
then there is no need to install the Oracle client.

Note: After Oracle Business Intelligence Enterprise Edition installation, save a 
snapshot of the last page of Oracle Business Intelligence Enterprise Edition 
installation having details of BI Oracle Home, Instance Home, etc. These 
values will be used during the Oracle Utilities Analytics installation.
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Deployment
A standard deployment of the Oracle Utilities Analytics product consists of a database and an 
application server. Two Weblogic installations are performed on the application server, one for 
Oracle Business Intelligence Enterprise Edition and another for Oracle Data Integrator. And, 
Oracle GoldenGate is installed on the source database server and on the target database server.

The diagram below depicts a standard deployment of the Oracle Utilities Analytics product.
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Operating Systems and Application Servers
Oracle Utilities Analytics installation is supported to operate on many operating system, 
application server, and database server combinations.

The following table details the minimum versions of the browser, operating system, and 
application server combinations on which Oracle Utilities Analytics v2.5.2.0.1 has been tested and 
supported: 

Browser
Operating 

System
(Client)

Operating 
System
(Server)

Chipset
Application 

Server

Oracle 
Business 

Intelligence 
Enterprise 

Edition 
(OBIEE)

Oracle 
Data 

Integrator 
(ODI)

JDK
Oracle 

GoldenGate

Oracle 
REST 
Data 

Service

Database

IE 11.x

Firefox 
34.0ESR
+ 
(OBIEE 
only)

Windows 
7/8(64 
Bit)

AIX 7.1 
(64-bit) 

Power 
64-bit

WebLogic 
10.3.6

11.1.1.7.1 11.1.1.7 1.6.0 2.4 12.1.2.1.1 3.0 Oracle 
12.1.0.2.0 

Oracle 
Linux 6.5 
(64-bit) 

x86_64 WebLogic 
10.3.6

11.1.1.7.1 11.1.1.7 1.6.0 (35) 12.1.2.1.0 3.0 Oracle 
12.1.0.2.0 

Oracle 
Solaris 11 
(64-bit)

SPARC WebLogic 
10.3.6

11.1.1.7.1 11.1.1.7 1.6.0 (35) 12.1.2.1.0 3.0 Oracle 
12.1.0.2.0 

Windows 
Server
2008 R2
(64-bit)

x86_64 WebLogic 
10.3.6

11.1.1.7.1 11.1.1.7 1.6.0 (35) 12.1.2.1.0 3.0 Oracle 
12.1.0.2.0 

Important Note: For the latest system requirements and supported platforms 
details, refer to the knowledge article “System Requirements and Supported 
Platforms for Oracle Utilities Analytics v2.5.2 (Doc ID 2041305.1)” available 
on My Oracle Support (https://support.oracle.com/). 

Important Note: Oracle Utilities Analytics supports Oracle Data Integrator 
based ELT only from the following combination of source and target databases. 

11g source --> 12c target

12c source --> 12c target

For Oracle Utilities Meter Data Management and Oracle Utilities Mobile Workforce 
Management source systems, make sure the source database is on Oracle Database 
Server 12c.

You must have the software listed below:

• Oracle Utilities Analytics version v2.5.2.0.1 is supported on Oracle Database Server Standard 
Edition 12.1.0.2.0 when using ELT component based on Oracle Data Integrator.

• Oracle Business Intelligence Enterprise Edition (OBIEE) 11g is required for Oracle Utilities 
Analytics Dashboards. 

• Oracle Data Integrator, Oracle GoldenGate, Oracle WebLogic and Oracle Application 
Express are required for Oracle Utilities Analytics ELT component based on Oracle Data 
Integrator. 

• JDK 1.6.0 (35) and JDK 1.7.0+.
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Supported Source Application Versions
The following are the supported source application versions:

Source Application Version

Oracle Utilities Customer Care and Billing 2.3.1
2.4.0.2
2.4.0.1
2.5.0

Oracle Utilities Network Management System 1.12.0.2
1.11.0.4.24

Oracle Utilities Work and Asset Management  1.9.1.2 

Oracle Utilities Meter Data Management 2.1.0.3

Oracle Utilities Mobile Workforce Management 2.2.0.3

Oracle Real-Time Scheduler 2.2.0.3

Oracle Utilities Operational Device Management 2.0.1.2

 

Note: For the latest edge application version details, refer to the knowledge 
article “System Requirements and Supported Platforms for Oracle Utilities 
Analytics v2.5.2 (Doc ID 2041305.1)” available on My Oracle Support (https:/
/support.oracle.com/). 

Note: Oracle Warehouse Builder based ETL is used for Oracle Utilities Work 
and Asset Management source application. If you are planning to use Oracle 
Utilities Work and Asset Management as a source application, contact Oracle 
Support personnel for detailed instructions on the installation process.

Additional Notes on the Supported Platforms
The following topics are discussed in this section: 

• Oracle Unbreakable Enterprise Kernel

• Oracle VM Support

• Oracle Support Policy on VMWare

Oracle Unbreakable Enterprise Kernel
Oracle Utilities Analytics is supported on Oracle Unbreakable Enterprise Kernel.

Oracle VM Support
Oracle Utilities Analytics is supported on Oracle VM Server for x86 3.3 for the supported releases 
of Oracle Linux and Microsoft Windows operating systems.
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Oracle Support Policy on VMWare
Refer to the knowledge base article ID 249212.1 on My Oracle Support (https://
support.oracle.com) for Oracle's support policy on VMWare.
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Chapter 3
Oracle Utilities Analytics Initial Installation

This chapter provides an overview of how to install Oracle Utilities Analytics. This section 
includes the following topics:

• Installing Oracle Utilities Analytics Database Component

• Installing Oracle Data Integrator Based ELT Component

• Installing Oracle Utilities Analytics Administration Component

• Installing Oracle Utilities Analytics Dashboards Component

Installing Oracle Utilities Analytics Database Component
Note: Install Oracle Utilities Analytics Database component on the Oracle 
Utilities Analytics database server.

Note: Verify that the prerequisite software products mentioned in the section 
Prerequisite Software for Oracle Utilities Analytics Database Component are 
installed.

This section describes how to install the database component of Oracle Utilities Analytics 
v2.5.2.0.1. It includes the following topics:

• Copying and Decompressing the Install Media

• Creating the Database

• Creating the Users and the Tablespaces

• Installing the RELADM Schema

• Installing the MDADM Schema

• Installing the DWADM Schema

• Configuring the Spatial Data

Copying and Decompressing the Install Media
To copy and decompress the install media, perform these steps:

1. Download Oracle Utilities Analytics version 2.5.2.0.1 Oracle Database part (Oracle Utilities 
Analytics V2.5.2.0.1 Oracle Database Multiplatform.zip) from the Oracle Software 
Delivery Cloud (https:// edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp for a Windows machine or /OUA/temp 
for a Linux machine. This directory (referred as <TEMPDIR> below) must be located 
outside any current working Oracle Utilities application environment. All files that are placed 
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in this directory as a part of the installation, can be deleted after completing a successful 
installation.

3. Unzip Oracle Utilities Analytics V2.5.2.0.1 Oracle Database Multiplatform.zip to 
<TEMPDIR> using any zip utility.

4. Unzip the zip file <TEMPDIR>/OUA-V2.5.2.0.1-Database-Multiplatform.zip using any 
zip utility.

Creating the Database
Ensure that Oracle Database Server Enterprise Edition 12.1.0.2.0 is already installed on the 
machine in order to create the database. Use the Database Configuration Assistant (DBCA) 
utility to create the database. 

Note: Refer to Oracle database documentation to know more about the 
Database Configuration Assistant (DBCA).

For an initial installation database creation, it is recommended that you use the Database 
Configuration Assistant to create a database with the AL32UTF8 character set. Set the open 
cursor limit to 3000 and processes to 1000 at the time of the database creation.

Creating the Users and the Tablespaces
Perform the following steps for creating the required users and the tablespaces:

1. Create users in the database with the following names: DWADM, DWUSER, DWREAD, 
MDADM, RELADM, MASTER_REPO, WORK_REPO and DWSTAGE without giving 
specific roles.

2. Create roles with the following names: DW_USER, DW_READ, DW_PRIVS_ROLE and 
DW_REPLICATE roles.

3. Connect to the sys user, execute the Usersgrants.sql in BI252/Scripts/Usersgrants.sql. 
This SQL provides the required grants to the users created above.

Installing the RELADM Schema 
The RELADM schema is a metadata schema that consists of the database objects used for storing 
the product version and component installation information.

This section describes initial installation of the RELADM schema, including:

• Reviewing the Storage.par File

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. Provide the value: RELADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.
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• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• The location for jar files (the Jar files are bundled with the database package in 
BI252\RELADM\Jarfiles).

• Java Home (for example: C:\Java\jdk1.6.0_20).

Reviewing the Storage.par File
The storage.par file (that comes with the product and is in location ..\BI252\RELADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that Oracle database server uses to access a table or 
to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the RELADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
Storage.par file to indicate the correct tablespace name on which 
RELADM has quota.

Installation Steps
Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 12c 32 bit client and the Java Development Kit 
Version 6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle 
client is updated with the entry for the target database to connect to the target 
database.

Perform the following steps to install the RELADM schema:

1. Run the CDXDBI.exe from ..\BI252\RELADM\Install-Upgrade. Run the utility from the 
command prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database: <DB NAME>.

• The password for the system user account in the database (in silent mode).

• The name of the owner of the database schema: RELADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI252\RELADM\Jarfiles>.

• The password for the user (in silent mode): <RELADM user password>.

• The Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle user with the read-only privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• The Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates the RELADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.
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Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing the MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing 
the metadata of Oracle Utilities Analytics. For example, ETL job execution status, target tables for 
ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including: 

• Reviewing the Storage.par File

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. Provide value: MDADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• The location for jar files (the Jar files are bundled with the database package in 
BI252\MDADM\Jarfiles).

• Java Home (for example: C:\Java\jdk1.6.0_20).

Reviewing the Storage.par File
The storage.par file (that comes with the product and is in location ..\BI252\MDADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a table 
or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the MDADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
Storage.par file to indicate the correct tablespace name on which 
MDADM has quota.
Oracle Utilities Analytics Initial Installation 3-4 
Oracle Utilities Analytics Installation Guide



Installation Steps
Perform the following steps to install the MDADM schema:

Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 12c 32 bit client and Java Development Kit Version 
6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle client is 
updated with the entry for the target database to connect to the target database.

1. Run the CDXDBI.exe from ..\BI252\MDADM\Install-Upgrade. Run the utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database:<DB NAME>.

• The password for the system user account in the database (in silent mode).

• The name of the owner of the Database Schema: MDADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI252\MDADM\Jarfiles>.

• The password for the user (in silent mode).

• The Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle user with the read-only privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• The Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates the MDADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

Installing the DWADM Schema 
The DWADM schema contains the star schema objects such as facts and dimensions that contain 
all the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:

• Reviewing the Storage.par File

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. For example, DWADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER.
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• A user with the read-only privileges to the objects in the application schema. For example, 
DWREAD.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. For example: DW_USER. The application will access the database 
as DW_USER.

• A database role with the read-only privileges to the objects in the application schema. For 
example, DW_READ.

• The location for jar files (the Jar files are bundled with the database package in 
BI252\DWADM\Jarfiles).

• Java Home (for example: C:\Java\jdk1.6.0_20).

Reviewing the Storage.par File
The storage.par file (that comes with the product and is in location ..\BI252\DWADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a table 
or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the DWADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
Storage.par file to indicate the correct tablespace name on which 
DWADM has quota.

Installation Steps
Perform the following steps to install the DWADM schema:

Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 12c 32 bit client and Java Development Kit Version 
6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle client is 
updated with the entry for the target database to connect to the target database.

1. Run the CDXDBI.exe from ..\BI252\DWADM\Install-Upgrade. Run the utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database: <DB NAME>.

• The password for the system user account in the database (in silent mode).

• The name of the owner of the Database Schema: DWADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI252\DWADM\Jarfiles>.

• The password for the user (in silent mode).

• The Oracle user with the read-write privileges to the database schema: DWUSER.

• The Oracle user with the read-only privileges to the database schema: DWREAD.

• The Oracle database role with the read-write privileges to the database schema: 
DW_USER.

• The Oracle database role with the read-only privileges to the database schema: 
DW_READ.
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2. If you choose to continue, the CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace if 
they do not exist.

3. After setting up roles and users, the utility continues installing schema and system data 
definitions. 
If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');

Configuring the Spatial Data
Refer to the Chapter 6: Spatial Configuration for the details regarding the spatial configuration.

Installing Oracle Data Integrator Based ELT Component
Note: Install the Oracle Utilities Analytics Based ELT component on the 
Oracle Utilities Analytics application server (refer to the section Deployment 
for the details on deploying Oracle Utilities Analytics).

Note: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics ELT component that is used to install all the related 
software. 

Note: Source application set up is a prerequisite in order to install Oracle Data 
Integrator based ELT component. The source applications should be setup 
with the required configurations before proceeding with the Oracle Data 
Integrator based ELT component installation in order to successfully extract 
data from them, to Oracle Utilities Analytics.

Note: Verify that the prerequisite software products mentioned in the section 
Prerequisite Software for Oracle Data Integrator Based ELT Component are 
installed.

Note: While installing Oracle Data Integrator, do not create any repositories. 
Select Skip Repository Configuration option.

Note: While installing Oracle Data Integrator, select the Developer 
Installation and Java EE Installation options in the Select Installation 
Type step.

This section describes how to install the ELT component of Oracle Utilities Analytics. The section 
includes the following:

• Setting up Oracle GoldenGate

• Copying and Decompressing the Install Media

• Starting the Installer

• Creating the Required Directories and Files

• Installation Steps

• Creating a Database Directory

• Creating the WebLogic Domain for Oracle Data Integrator Agent
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• Starting the WebLogic Admin Server

• Authenticating the Oracle Data Integrator Supervisor User in WebLogic and Starting the 
Managed Server

Setting up Oracle GoldenGate
Note: This section describes setup required in Oracle GoldenGate to work 
with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer to its 
installation document.

Download Oracle GoldenGate 12.1.2.0.0 from the Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com) and set up Oracle GoldenGate on the source and the target database servers. 

This section describes the following: 

• Setting up Oracle GoldenGate on the Source Database Server

• Setting up Oracle GoldenGate on the Target Database Server

Setting up Oracle GoldenGate on the Source Database Server
Perform the following steps for each source instance: 

1. Create a directory on the source database server. For example, ../GoldenGate Home. 
Oracle GoldenGate should be installed in this directory. This will be Oracle GoldenGate 
home (OGG_Home) on the source database server.

Important Note: Make a note of this directory location; it will be used during 
the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the 
directory location created in the step 1.

3. Open a command terminal/window, and set the source ORACLE_SID and 
ORACLE_HOME variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%

4. In the Command window, change directory to the Oracle GoldenGate home directory, and 
execute the command:

For Unix:

./ggsci

For Windows:

ggsci

This opens the Oracle GoldenGate prompt.

5. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.

6. On the Oracle GoldenGate prompt, execute the start mgr command to start the Oracle 
GoldenGate manager process.

7. On the Oracle GoldenGate prompt, execute the info all command to view the manager 
process is running. Exit Oracle GoldenGate by executing the Exit command.
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8. Ensure that the source database is in the archivelog mode.

9. Connect to the source database as the sys user and execute the alter database add 
supplemental log data (primary key) columns command.

10. Go to the Oracle GoldenGate home (OGG_Home) directory.

11. Connect to the database as the sys user using the SQL*Plus (OGG_Home should be the 
current directory while invoking SQL*Plus). 

12. Create a new user, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and 
make sure to assign a tablespace to this user that is not assigned to any other user. 

Important Note: Make a note of the GoldenGate Owner Username; it will be 
used during Oracle Utilities Analytics installation.

13. Connect to the source database with sys user and execute the following commands: 

Note: Make sure to change GoldenGate owner placeholder with actual name 
of database user as created in previous step. 

grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate 
Owner>; 
grant unlimited tablespace to <GoldenGate owner> with admin 
option;
EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate 
Owner>','capture'); 
grant unlimited tablespace to <GoldenGate Owner> with admin 
option;
Revoke dba from <GoldenGate Owner>; 
grant create any view to <GoldenGate Owner>;
grant select any dictionary to <GoldenGate Owner>;
GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>; 
GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>; 
GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>; 

14. Connect to the source application ADM schema such as CISADM, and execute the below 
commands:

For Oracle Utilities Customer Care and Billing source database, execute the following 
grants:

Grant select on F1_MST_CONFIG to < GoldenGate owner user created in the step 
mentioned above>

Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in the 
step mentioned above >

Grant select on F1_BKT_CONFIG to < GoldenGate owner user created in the step 
mentioned above >

Grant select on F1_BKT_CONFIG_VAL to < GoldenGate owner user created in the 
step mentioned above >

For Oracle Utilities Operational Device Management source database, execute the 
following grants:

Grant select on F1_MST_CONFIG to < GoldenGate owner user created in the step 
mentioned above>

Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in the 
step mentioned above>
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For Oracle Utilities Meter Data Management source database, then execute the 
following grants:

Grant select on <application ADM Schema>.F1_MST_CONFIG to

<GoldenGate Owner>;

Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to

<GoldenGate Owner>;

Note: While executing the SQL commands in the steps 16, 17 and 18, provide 
the GoldenGate owner user if prompted for. All the scripts mentioned below 
are located in GoldenGate Home directory and must be executed after 
connecting to the sys user.

15. Run the command: 
@marker_setup.sql

16. Run the command: 
@ddl_setup.sql

17. Run the command: 
@role_setup.sql

18. Exit the SQL*Plus login and create a directory named diroby inside OGG_Home directory.

19. Change directory to the Oracle GoldenGate home directory, and execute the following steps:

Note: The following pre-requisite steps are to be executed before running the 
OUA installer. Refer to the Oracle GoldenGate Administering Oracle GoldenGate 
Guide for more info.

Configuration for Encrypting Data with the ENCKEYS Method

a. Execute the following command:

cd $OGG_HOME
./KEYGEN key_length n

The above command generates the key value based on the value specified in the 
parameter "n". The key value has to be copied to ENCKEYS file against a logical name.

b. For each key value generated above, provide a logical name (Logical name should not be 
the same for two different key values). Enter the logical name space and then key value in 
the ENCKEYS file. 

c. Repeat the step above for each key values generated. 

d. Save the file with name ENCKEYS (Upper case only) without any extension.

Example: 

cd $OGG_HOME
./keygen 128 1
0x8CE55035DD6893205A7BD6773FA8E670

e. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an 
existing ENCKEYS text file to append.

bash-4.1$ vi ENCKEYS

f. Input the Logical name, space and key value generated.

bash-4.1$ cat ENCKEYS
CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
bash-4.1$
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g. The source ENCKEYS file entry has to be appended to the intermediate server or target 
server which would be configured with the source system where target OGG is being 
configured.

Note: It is recommended to name Logical key name after 
<context_code>KEY. For example: if context code is CCB1, it is 
recommended to name CCB1KEY.

Generating the shared secret password

a. Execute the following command:

cd $OGG_HOME
./ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY 

<key_name>

Example:

cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY 

CCB1KEY
Encrypted password: 

AADAAAAAAAAAAAIAVGNHBFLGFCHBTCVBFJFHUEJGNCFAOAFEOFBALELISFOEIFWGRBZHCC
MCYGYBDAZH

Algorithm used: AES128

b. Note down the above generated ENCKEYS file Logical name/key value, algorithm 
name used and the generated Encrypted password.

c. This information will be required while configuring the source. Please refer to the Admin 
Guide for instructions on source configuration.

Setting up Oracle GoldenGate on the Target Database Server
Perform the following steps: 

1. Create a directory on the target database server. For example,  ../GoldenGateHome. 
Oracle GoldenGate should be installed in this directory. This will be Oracle GoldenGate 
home (OGG_Home) on the target Oracle Utilities Analytics database server.

Important Note: Make a note of this directory location; it will be used during 
the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the 
directory location created in the step 1.

3. Open a Command window and set the target ORACLE_SID and ORACLE_HOME 
variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%

4. In the Command window, change the directory to the GoldenGate home directory and 
execute the command:

For Unix:

./ggsci
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For Windows:

ggsci
This opens the Oracle GoldenGate prompt.

5. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.

6. On the Oracle GoldenGate prompt, execute the start mgr command to start the Oracle 
GoldenGate manager process.

7. On the Oracle GoldenGate prompt, execute the info all command to view the manager 
process is running.

8. Exit Oracle GoldenGate by executing exit command and create a directory named diroby 
inside the OGG_Home directory.

Copying and Decompressing the Install Media
To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.5.2.0.1 Multiplatform part (Oracle 
Utilities Analytics V2.5.2.0.1 Multiplatform.zip) from the Oracle Software Delivery Cloud 
(https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.5.2.0.1 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
Go to the temporary folder where you have downloaded the installer and run the following 
command from this folder:

java -jar <TEMPDIR>/OUA_2.5.2.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.7. 
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The Welcome page appears. Review this information before you begin the installation and click 
Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each 
item in the navigation pane represents a specific installer screen that will prompt you for 
information required to install the software.

If you select Oracle Data Integrator Based ETL as an Installation Type, you need to define 
Database and Java Home Details, Target Database Connection Details, Oracle Data 
Integrator Home and Schema Details, Oracle Data Integrator Agent and Repository 
Details and Target GoldenGate Details.

If you select Dashboard as an Installation Type, you need to define Database and Java Home 
Details, Target Database Connection Details and OBIEE Home Details.

 If you select both Oracle Data Integrator Based ETL and Dashboard as an Installation 
Type, you need to define Database and Java Home Details, Target Database Connection 
Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator Agent 
and Repository Details, Target GoldenGate Details and OBIEE Home Details.

Creating the Required Directories and Files
Before running the installer for Oracle Utilities Analytics for the first time on any server, the 
following directories need to be created (only applicable for windows):

C:\spl\etc
C:\spl\temp

Before running the installer for Oracle Utilities Analytics for the first time on any server, the 
following files need to be created:

• On windows:

C:\spl\etc\cistab

• On Unix:

/etc/cistab

Permissions on the cistab file should be set in such a way that the user that is used to run the 
installer has at least read permission on the file.
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Note: If you are running installer multiple times on a server, make sure there is 
no file named ENVIRON.INI in /tmp (for unix) or C:\spl\temp (for 
windows) before invoking the installer.

Installation Steps
To install Oracle Data Integrator Based ETL, perform the following steps

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this 
information before you begin the installation and click Next to continue with the installation.

2. The Installation Location page appears. Define the Installation Location here and click 
Next. 

Note: The specified Oracle home directory must be an empty directory.

3. The Select Installation Type page appears. In the Select Installation Type page, select 
ODI Based ETL and click Next. 

Note: Based on the selected installation type, the options on the left navigation panel 
changes. When you select Oracle Data Integrator Based ETL as an Installation Type, 
you need to define Database and Java Home Details, Target Database Connection 
Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator 
Agent and Repository Details and Target GoldenGate Details.

4. The Database and Java Home Details page appears. Enter the following details in the 
respective fields and click Next.

Field Name Description Value

Database Client Home This is the database client 
home location.

Example: /u01/app/product/
12.1.0/dbhome_1

Java Home This is the JDK home loca-
tion.

Provide location of JDK 1.6 
(1.6.0_35+)
Example: /u01/jdk_1.6.0_35

5. The Target Database Connection Details page appears. Enter the following details in the 
respective fields and click Next:

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).
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6. The ODI Home and Schema Details page appears. Enter the following details in the 
respective fields and click Next:

Field Name Description Value

Weblogic Home The directory where 
WebLogic to be used for 
Oracle Data Integrator has 
been installed.

Example:
/u01/Middleware/wlserver_10.3

ODI Home The directory where Oracle 
Data Integrator (ODI) has 
been installed.

Example:
/u01/Middleware/Oracle_ODI1

Supervisor User The name of the Oracle Data 
Integrator Supervisor.

SUPERVISOR 

Supervisor Password The password of the Oracle 
Data Integrator Supervisor.

SUPERVISOR user password

Confirm Supervisor 
Password

Confirm the password of the 
Supervisor here.

Master Repository 
Schema Name

Oracle Data Integrator master 
repository schema name.

MASTER_REPO

Master Repository 
Schema Password

The password of the master 
repository schema.

MASTER_REPO user's 
password

Confirm Master 
Repository Schema 
Password

Confirm the password of the 
Oracle Data Integrator master 
repository schema here.

Work Repository 
Schema Name

Oracle Data Integrator work 
repository schema name.

WORK_REPO

Work Repository 
Schema Password

The password of the work 
repository schema.

WORK_REPO user's password

Confirm Work 
Repository Schema 
Password

Confirm the password of the 
Oracle Data Integrator work 
repository schema here.

7. The ODI Agent and Details page appears. Enter the following details in the respective 
fields and click Next:

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

Field Name Description Value

ODI Agent Host The host on which Oracle 
Data Integrator WebLogic 
Domain is created.

It is Oracle Data Integrator 
Server host name.

Field Name Description Value
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Note: Oracle Data Integrator imposes certain restrictions on the source for the 
objects imported. Each environment should have a unique Work Repository ID 
and Master Repository ID. The Master and Work Repository IDs should be 
greater than 600. The ID values less than 600 should not be used as these are 
reserved for the base repository from Oracle Utilities Analytics product. Failure 
to comply to this rule, would result in ID conflicts during upgrades to newer 
releases of Oracle Utilities Analytics. 

8. The Target GoldenGate Details page appears. Enter the following details in the respective 
fields and click Next:

ODI Agent Port The port on which Oracle 
Data Integrator WebLogic 
agent is configured to run. 
This is the port of Oracle 
Data Integrator WebLogic 
Managed Server Port.

Provide available port and make 
sure to use the same port while 
creating Oracle Data Integrator 
managed server.

Master Repository ID Oracle Data Integrator Master 
Repository ID.

The default value is 601.

Work Repository ID Oracle Data Integrator work 
Repository ID. 

The default value is 602.

Field Name Description Value

GoldenGate Host The host on the Oracle 
GoldenGate Manager.

GoldenGate Home This is the Oracle 
GoldenGate installed 
location. 

Example: /opt/local/
ggs_12.1.2.0.0

Target Database Home This is the database home 
installed location on the target 
database server. 
In case GoldenGate for target 
is not installed on the Oracle 
Utilities Analytics database 
server, provide oracle client 
home location on the server 
on which GoldenGate is 
installed.

Example: /u00/oracle/app/
oracle/product/11.2.0/
dbhome_1

GoldenGate Manager 
Port

The port number on which 
Oracle GoldenGate Manager 
is running on the GoldenGate 
host.

The default value is 7830

GoldenGate Dynamic 
Min Port

This is the dynamic minimum 
port configured in Oracle 
GoldenGate.

Provide the start range value set 
for the target GoldenGate 
manager process. The default 
value is 7830.

Field Name Description Value
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9. The Add Cistab Entry page appears.

10. Register the installed Oracle Utilities Analytics environment in the /etc/cistab file for Unix 
based Operating systems and in the C:\spl\etc\cistab file for Windows Operating system. 
The cistab file needs to be created in the specified location if it does not already exist. Copy 
the text shown, add the text in a new line in the cistab file and save the file. Click Next.

11. The Installation Summary page appears. Verify the installation options you selected.

12. Click Install to begin the installation. 

If you want to make any changes to the configuration before starting the installation, use the 
navigation pane and select the topic you want to edit.

13. The Installation Progress page appears which allows you to see the progress of the 
installation. Operations being performed as a part of the installation are logged to the 
terminal from which the installer was run. The Detailed logs of the installation are also 
available in the logs/system directory under the installation location.

If you want to quit before the installation is completed, click Cancel. Doing so will result in a 
partial installation; the portion of the software that was installed on your system before you 
click Cancel will remain on your system, and you will have to remove it manually.

14. In the Installation Completed page, click Finish to dismiss the installer.

The Oracle Data Integrator based ETL is now installed.

Note: To configure source, refer to the Chapter 5: Configuring Oracle 
Utilities Analytics in Oracle Utilities Analytics Administration Guide.

Creating a Database Directory
Create a database directory 'B1_DATA_DUMP_DIR' on the target database. This directory is 
used for logging the export import task used during the initial ELT load. The following is a sample 
SQL that creates the database directory pointing to the file system path /scratch/file_data: 

CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';

GoldenGate Dynamic 
Max Port

This is the dynamic maximum 
port configured in Oracle 
GoldenGate on the target 
database server.

Provide the end range value set 
for the target GoldenGate 
manager process. The default 
value is 7880.

GoldenGate Algorithm This is the algorithm 
configured in Oracle 
GoldenGate on the target 
database server.

The default value is 1.

GoldenGate 
Encryptkey

This is the Encrypt Key 
configured in Oracle 
GoldenGate on the target 
database server. 

The default value is 
“DEFAULT”.

GoldenGate Shared 
Secret

This is shared secret key 
configured in Oracle 
GoldenGate on the target 
database server. The default 
value is"DEFAULT”.

Go to the Oracle GoldenGate 
prompt and run the command: 
encrypt password <password of 
MDADM user>, encryptkey 
DEFAULT 
Provide the result of above 
command as the value.

Field Name Description Value
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Creating the WebLogic Domain for Oracle Data Integrator Agent
The WebLogic Domain should be created for bringing up the WebLogic Agent (ODI Agent) to 
complete the steps. 

Perform the following steps to bring up the WebLogic ODI Agent:

1. Navigate to the Oracle Data Integrator (ODI) installed location <MW_HOME>/
Oracle_ODI1\common\bin, run the below command and follow the steps to provide the 
masterschema and workschema provided in the configuration.

For Unix: 

• Run ./Config.sh

For Windows: 

• Run Config.cmd

2. Create a new WebLogic domain. 

Click Next.

3. Generate a domain configured automatically to support the following products. Select the 
checkboxes for the below mentioned plugins. When these plugins are selected, some 
automatic plugins also get selected.

• Oracle Enterprise Manager Plugin for Oracle Data Integrator -11.1.1.0

• Oracle Data Integrator - Console - 11.1.1.0

• Oracle Data Integrator Agent - 11.1.1.0
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• Oracle Data Integrator - SDK Web Services - 11.1.1.0

Then, click Next to proceed. 

4. On the Specify Domain Name and Location page, complete the following: 

• Provide the domain name: odi_domain 

• Location will be default

Click Next to proceed.
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5. Configure the Administrator User Name and Password for the WebLogic.
Provide the WebLogic password.

Click Next. 

6. Configure the Server StartUp Mode and JDK:

• Select the Production Mode option.

• Provide the JDK 1.6.0_35 

7. Configure the JDBC Component Schema. 

Select only the ODI Master Schema checkbox. Provide the below details:

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port
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• Schema Owner: MASTER_REPO

• Schema Password: MASTER_REPO Password

8. Deselect the ODI Master Schema checkbox.

9. Select the ODI Work Schema checkbox. Provide the below details: 

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: WORK_REPO

• Schema Password: WORK _REPO Password

Click Next to proceed. 

10. Test the JDBC Component Schema by selecting the Select All and the Test Connections. 

Click Next to proceed. 
Oracle Utilities Analytics Initial Installation 3-21 
Oracle Utilities Analytics Installation Guide



11. Select the Optional Configuration:

• Select the checkboxes: 

• Administration Server

• Managed Server, Clusters and Machines

Select Next to proceed.

12. Configure the Administration Server:

• Provide the Listening Port, which is not in use.

Click Next to proceed. 

13. Configure the Managed Servers by providing the following: 

• Name: odi_server1
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• Listen Address: All Local Addresses

• Port: Provide the port, which is provided in the step 7 in the section Installation Steps.)

14. Configure the Cluster. 
Click Next. 

15. Configure the Machines. 
Click Next. 

16. Assign the Servers to Machines. 
Click Next.

17. On the Configuration Summary page, click Create to create the domain odi_domain. 

18.  After the domain is created, go to the domain location, create the boot.properties file for 
WebLogic login. Create the <MW_HOME>/user_projects/domains/odi_domain/
servers/AdminServer/security folder if not present. 

19. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security, then create boot.properties file with the below values:

• username=weblogic

• password=Weblogic password

20. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/
odi_server1/security folder if not present.

21. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/
security, and then create boot.properties file with the below values:

• username=weblogic

• password=Weblogic password

Starting the WebLogic Admin Server 
Perform the following steps: 

1. In the command shell, change the directory to the directory of the WLS Home -
<MW_HOME>/user_projects/domains/odi_domain/bin.
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2. Execute the startweblogic command for UNIX and Windows:

For Unix:

nohup ./startWebLogic.sh > startWebLogic.log &

For Windows: 

startWebLogic.cmd

Authenticating the Oracle Data Integrator Supervisor User in WebLogic and 
Starting the Managed Server

Perform the following steps:

1. Go to <MW_HOME>/oracle_common/common/bin.

2. Execute the following command:

For Unix:

./wlst.sh

For Windows: 

wlst.cmd

3. To connect to the running Admin server, execute the following command:

connect('<Weblogic User>','<Weblogic password>','t3://
<WEBLOGICHOST>:<WEBLOGIC ADMIN PORT')

For example: connect('weblogic','weblogic123','t3://localhost:7001')

4. Execute the following command to add the correct credential store for the Oracle Date 
Integrator Supervisor:

createCred (map="oracle.odi.credmap", key="SUPERVISOR", 
user="SUPERVISOR", password="<SUPERVISOR Password>", desc="ODI 
SUPERVISOR Credential")

5. To exit WebLogic Scripting Tool (WLST), execute the exit () command. 

Starting Managed Server odi_server1
Perform the following steps: 

1. To start managed server odi_server1, change the directory to the WLS Home: 

<MW_HOME>/user_projects/domains/odi_domain/bin

Execute the below commands: 

For Unix: 

nohup ./startManagedWebLogic.sh  odi_server1 > 
StartManagedWeblogic.log &

For Windows: 

StartManagedWeblogic.cmd odi_server1
2. From the Oracle Data Integrator Studio, navigate to Topology > Agents> 

OracleDIAgent. Right-click on OracleDIAgent and click Test to test connectivity of 
configured Oracle Data Integrator Java EE agent.
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Installing Oracle Utilities Analytics Administration Component
Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based 
configuration tool that can be used to configure Oracle Utilities Analytics. This section describes 
how to install the Administration Tool for Oracle Utilities Analytics configuration and change the 
default password of the Admin user, including:

• Installation Steps

• Changing the Default Password of the Admin User

Note: Install the Oracle Utilities Analytics Administration component on the 
Oracle Utilities Analytics database server.

Installation Steps
Note: Verify that the prerequisite software products mentioned in the section 
Prerequisite Software for Oracle Utilities Analytics Administration Tool 
Component are installed.

Perform the following steps to install Oracle Utilities Analytics Administration Tool:

1. Download Apex 4.2.6 and copy to database server under the /temp directory.
Unzip the file.

cd /temp/apex

Connect to the Oracle Utilities Analytics database with the sys user and execute the following 
command:

a. @apxremov.sql

b. @apxrtins <Tablespace name> <Tablespace name> <Temp Tablespace name> /i/

 For example, @apxrtins CISTS_01 CISTS_01 TEMP /i/

c. @apxchpwd.sql

d. ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;

e. ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;

f. @apex_rest_config.sql

You must remember the password for these two users, APEX_Listener user and 
APEX_REST_PUBLIC_USER

2. Import the Admin Tool for Oracle Data Integrator configuration:

a. Unzip the Oracle Utilities Analytics V2.5.2.0.1 Multiplatform.zip file. This file has a 
folder called AdminTool.

b. Create the ../AdminTool directory on the database server and copy the contents of the 
AdminTool directory (from the zip file) to this directory.

c. Go to the ../AdminTool directory, i.e., cd ../AdminTool.

d. Connect as the system user and execute the following scripts:

• Create the workspace and configure the users:
@CreateAppWorkspace.sql
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• Import application:
@DeployAdminApp.sql

• Deploy supporting objects:
@DeploySupportingObjects.sql

3. Download Apex 4.2.6 and copy to the server where you want to set up the Administration 
Tool under /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory.

Note: Create /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory if it 
does not exist.

4. Download Oracle Rest Data service and copy to the server where you want to set up the 
Administration Tool under /scratch/bi_oradata_01/Softwares/apex_listner directory.

Note: Create /scratch/bi_oradata_01/Softwares/apex_listner directory if it 
does not exist.

5.  Navigate to the scratch/bi_oradata_01/Softwares/apex_listner directory and unzip the file  
ords.3.0.0.121.10.23.zip.

cd /scratch/bi_oradata_01/Softwares/apex_listner

6. Navigate to the cd /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory and unzip the 
file apex_4.2.6_en.zip.

 cd /scratch/bi_oradata_01/Softwares/apex_4.2.6

7. Create a directory on the server for the Apex configuration. 
For example, mkdir/scratch/bi_oradata_01/apex_configuration

8. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory:

cd /scratch/bi_oradata_01/Softwares/apex_listner

9. Execute the following command:

java -jar ords.war install advanced

Note: Use JDK1.7 or later to execute.

Note: You need to provide the required inputs as shown below:
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10. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory:

cd /scratch/bi_oradata_01/Softwares/apex_listner

Execute the following command:

java -jar ords.war static /scratch/bi_oradata_01/Softwares/
apex_4.2.6/apex/images

Note: It creates i.war file.

11. Install Weblogic 10.3.6 with jdk 1.7.0+.

12. Create Weblogic domain.

Navigate to the <Middleware Home>/wlserver_10.3/commin/bin
cd <Middleware Home>/wlserver_10.3/commin/bin

Execute the following:
./config.sh

a. Click Next. 
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b. Provide the domain name and do not change the domain location. Click Next.

c. Provide Weblogic User Password and make sure to remember it.
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d. Select jdk1.7 and click Next.

e. Select the Administration Server, Managed Servers, Clusters and Machines options 
as shown below: 
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f. Provide Listen Port as available port and remember this port number. Click Next:

g. Click Add and provide values as shown below:
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h. Click Next:

i. Click Next.
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j. Click Next.

13. Create the boot.properties file.

14. Start the Admin and Managed server.

15. Log into Weblogic console and click on Lock & Edit.

16. Click on Install.

17. Provide Path as: /scratch/bi_oradata_01/Softwares/apex_listner and select the ords.war file
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18. Click Next.

19. Select the Apex Server option and click Next.
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20. Select the options as shown below:

21. Select the options as shown below:

22. Click Activate Changes.

23. Repeat the steps from 13 to 20 to deploy i.war file.
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24. Login to Weblogic console and click on Deployment> Monitoring. Select i and ords. And 
then, click on Start and select Servicing All Requests option.

25. Click Yes.

26. Restart the Admin and Managed servers.

27. Go to the following URL to access the Administration Tool:
http://<hostname>:<managed server port no>/ords/f?p=104

28. Credentials to access the Administration Tool:
User ID: Admin
Password: Admin_123
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Changing the Default Password of the Admin User
The following APEX API can be used to change the password of the admin user. This script 
should be run after connecting to the database as user SYSTEM.

The string 'New password' should be replaced with the new password for the admin account 
before running the script. 

begin
  

wwv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_flow_a
pplication_install.get_workspace_id,2090606133849294));

end;
/

begin
apex_util.edit_user(
p_user_id      => '2090514487849294',
p_user_name => 'ADMIN',
p_web_password => 'New password',
p_new_password => 'New password'
);
end;
/

commit;
/

Important Note: It is strongly recommended that you should change the 
default password after logging in.

Installing Oracle Utilities Analytics Dashboards Component
Note: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics Dashboards component that is used to install all the 
prerequisite software. 

Note: Verify that the prerequisite software products mentioned in the section 
Prerequisite Software for Oracle Utilities Analytics Dashboards Component are 
installed.

Note: Install the Oracle Utilities Analytics Dashboards component on the 
Oracle Utilities Analytics application server (refer to the section Deployment 
for the details on deploying Oracle Utilities Analytics).

This section describes how to install the dashboards component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing the Install Media

• Starting the Installer

• Installation Steps

• Deploying the Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying the MapViewer

• Post-deploying the Custom MapViewer

• Enabling WriteBack

• Enabling the Analytics Help
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• Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

Copying and Decompressing the Install Media
To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics Dashboards component v2.5.2.0.1 (Oracle Utilities 
Analytics V2.5.2.0.1 Multiplatform.zip) from the Oracle Software Delivery Cloud (https:/
/edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.5.2.0.1 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
Go to the temporary folder where you have downloaded the install and run the following 
command from this folder:

java -jar <TEMPDIR>/OUA_2.5.2.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.7. 

The Welcome page appears. Review this information before you begin the installation and click 
Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each 
item in the navigation pane represents a specific installer screen that will prompt you for 
information required to install the software.

Installation Steps
To install the Dashboards, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this 
information before you begin the installation and click Next to continue with the installation.
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2. The Installation Location page appears. Define the Installation Location here and click 
Next. 

Note: The specified Oracle home directory must be an empty directory.

3. The Select Installation Type page appears. In the Select Installation Type page, select 
Dashboards and click Next. 

Note: Based on the selected installation type, the options on the left navigation panel 
changes. When you select Dashboard as an Installation Type, you need to define Database 
and Java Home Details, Target Database Connection Details and OBIEE Home 
Details.

4. The Database and Java Home Details page appears. Enter the following details in the 
respective fields and click Next.

Field Name Description Value

Database Client Home This is the database client 
home location.

Example: /u01/app/product/
12.1.0/dbhome_1

Java Home This is the JDK home loca-
tion.

Provide location of JDK 1.6 
(1.6.0_35+)
Example: /u01/jdk_1.6.0_35

5. The Target Database Connection Details page appears. Enter the following details in the 
respective fields and click Next:

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.
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6. The OBIEE Home Details page appears. Enter the following details in the respective fields 
and click Next:

Field Name Description Value

BI Home The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/ Middleware/
Oracle_BI1

BI Instance Home This is the instance home 
location under the location 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/Middleware/ 
instances/instance1

BI Domain Home This is the domain home 
location under the location 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/ Middleware/
user_projects/domains/
bifoundation_domain

Weblogic Host The hostname on which 
weblogic server for Oracle 
Business Intelligence 
Enterprise Edition is running.

Weblogic Port Number A unique port number within 
the system that is assigned to 
the HTTP port. This is the 
port number that is used as a 
part of the client URL request 
to connect to the host. This is 
Oracle Business Intelligence 
Enterprise Edition WebLogic 
console admin port number. 

Example: 7001

Weblogic User WebLogic domain login user 
name. 

Note: You will be prompted for the Weblogic user’s password after installation, 
when configuring Oracle Utilities Analytics.

7. The Add Cistab Entry page appears. 

8. Register the installed Oracle Utilities Analytics environment in the /etc/cistab file for Unix 
based Operating systems and in the C:\spl\etc\cistab file for Windows Operating system. 
The cistab file needs to be created in the specified location if it does not already exist. Copy 
the text shown, add the text in a new line in the cistab file and save the file. Click Next.

9. The Installation Summary page appears. Verify the installation options here.

10. Click Install to begin the installation. 

If you want to make any changes to the configuration before starting the installation, use the 
navigation pane and select the topic you want to edit.

11. The Installation Progress page appears which allows you to see the progress of the 
installation. Operations being performed as part of the installation are logged to the terminal 
from which the installer was run. Detailed logs of the installation are also available in the 
logs/system directory under the installation location.
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If you want to quit before the installation is completed, click Cancel. Doing so will result in a 
partial installation; the portion of the software that was installed on your system before you 
click Cancel will remain on your system, and you will have to remove it manually.

12. In the Installation Completed page, click Finish to dismiss the installer.

The Dashboards component is now installed.

Deploying the Repository (RPD) File
If you have not made any changes to the deployed RPD, then take the RPD file from the following 
location: <install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd, where <install_dir> is the 
Oracle Utilities Analytics Dashboard Component installation directory.

If you have done merging, then take the merged RPD and make the required database changes.

This RPD file should be copied to the windows machine on which Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1 (Install Oracle Business Intelligence Enterprise Edition 11.1.1.7.0 
and apply the patch 18818588) is installed.

Follow these steps to deploy the RPD file:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should be installed on the 
Windows machine before proceeding with the below steps.

2. Launch the Administration Tool from the Start menu.
Start > Programs > Oracle Business Intelligence > BI Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is “oracle123”.
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5. Edit the Connection Pools shown below by double-clicking on them.

6. In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following (only for Oracle Utilities Meter 
Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 

9. In the MDM Database Connection group, provide the following (only for Oracle Utilities 
Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

10. In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD
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Password = DWREAD User password

12. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete.

13. Log into the Oracle Business Intelligence Enterprise Edition Enterprise Manager console.

14. Navigate to BI Instance > Coreapplication > Deployment.

15. Lock and edit.
The repository text box will be enabled.

16. Browse to the modified rpd file and submit. 

17. Provide the RPD password “oracle123”, and then click Apply.

18. Activate the changes and then restart Oracle Utilities Analytics services.

Note: All the above-mentioned database sets of the connection pool should be 
updated in the tnsnames.ora file in <OBIEE_INSTALL_DIR>/
Oracle_BI1/network/admin.

Deploying the Web Catalog
To deploy the web catalogs, follow these steps: 

1. Go to the <Catalog location>/root/shared and delete the existing catalogs that were 
delivered out-of-box with the Oracle Utilities Analytics product in the previous release. Any 
catalog added by you can be retained. If Oracle Utilities Network Management System BI 
publisher reports were deployed, they should be retained. 

2. Go to <Catalog location>/root/system and remove spatialmetadata directory and 
spatialmetadata.atr file.
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Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploycatalog.sh.

5. Enter the physical catalogs location configured in the Enterprise Manager. 
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd  %SPLEBASE%\bin.

4. deploycatalog.cmd.

5. Enter the Physical Catalogs location configured in the Enterprise Manager.
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

Configuring and Deploying the MapViewer
Configuring and deploying the MapViewer involves the following:

• Configuring the MapViewer

• Modifying the instanceconfig.xml

• Deploying the Custom MapViewer

Configuring the MapViewer
To configure Mapviewer, follow these steps: 

1. Log into the WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' datasource.

3. Lock and edit.

4. Navigate to Services > Data Sources.

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS

JNDI Name = MAP_DS 

Database Type = oracle

6. Click Next.

7. Enter the following:
Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions 9.0.1 and later 

8. Click Next. 
Oracle Utilities Analytics Initial Installation 3-43 
Oracle Utilities Analytics Installation Guide



9. Do not change any values on the next page and click Next.

10. Enter the following connection properties: 

• Database Name: BI Database Name 

• Host Name: Database host 

• Port: Database port

• Database User Name: dwadm

• Password: dwadm password

11. Click Next.

12. On the next page, click Test Configuration button. After the successful test, click Next 
again. 

13. The Select Target page opens. Now select AdminServer under Servers and bi_cluster under 
Clusters. Click Finish.

14. Click Activate Changes.

15. Update the mapViewerConfig file with the below-mentioned tags:

File location: <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/

mapviewer.ear/web.war/WEB-INF/conf/ 

File: mapViewerConfig.xml

16. If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node.

<proxy_enabled_hosts>
elocation.oracle.com
</proxy_enabled_hosts>

17. Add the following ns_data_provider node:

<ns_data_provider id="obieeNsdp" 
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

18. Add the current map_tile_server with the following map_tile_server node:

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

Modifying the instanceconfig.xml
Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesCo mponent\coreapplication_obips1
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Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>
3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>

Deploying the Custom MapViewer
Note: The custom MapViewer is required to integrate weather information 
into Outage Analytics.

To deploy the custom MapViewer, follow these steps: 

For UNIX: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploymapviewer.sh.

5. Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run deploymapviewer.cmd.

5. Enter WebLogic Domain Console password. For example, weblogic123.
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Post-deploying the Custom MapViewer
Perform the following steps after deploying the custom MapViewer:

1. Log into the MapViewer: http://<Server>:<port>/mapviewer.

2. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration. Login to the Mapviewer at this location: http://
<HOST>:<MANAGERPORT>/mapviewer

3. Add the below content in the mapViewerConfig.xml with the appropriate values:

<map_data_source name="MAPCONN"
jdbc_host="<DB server name>"
jdbc_sid="//<DB Service name>"
jdbc_port="1521"
jdbc_user="DWADM"
jdbc_password="!<DWADM user password>" 
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"
/>

Note: The exclamatory mark in the front of the password ensures that the 
password is encrypted. 

4. Click Save, and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Enabling WriteBack
For enabling the Write Back, perform the following steps:

1.  Log into Analytics and navigate to Administration>Manage 
Privileges>WriteBack>Write Back to Database.

2. Click Denied:Authenticated User and select the permission Granted.

Enabling the Analytics Help
To enable the Analytics’ Help, perform these steps: 

1. Download Oracle Utilities Analytics v2.5.2.0.1 Getting Started Guide from Oracle Software 
Delivery Cloud (https:// edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics v2.5.2.0.1 Getting Started Guide, change the name of 
the OUA_Getting_Started_Guide_2.5.2.0.1.pdf file to OUASA Help.pdf.

3. Place the Help file in <install_dir>/Skin/res, where <install_dir> is the Oracle Utilities 
Analytics Dashboard Component installation directory.

4. Run the following commands: 

For UNIX:
Perform the following steps: 

a. Navigate to <Install_Dir>/bin directory.

b. Initialize the environment with the ./splenviron.sh -e <envname> command.

c. cd $SPLEBASE/bin.

d. Run ksh ./deployanalyticsear.sh.

e. Enter the WebLogic Domain Console password. For example, weblogic123.
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For Windows:

Perform the following steps: 

a. Navigate to <Install_Dir>/bin directory.

b. Initialize the environment with the ./splenviron.cmd -e <envname> command.

c. cd %SPLEBASE%/bin.

d. deployanalyticsear.cmd.

e. Enter the WebLogic Domain Console password. For example, weblogic123.

f. Restart the Oracle Utilities Analytics core services.

g. Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business 
Intelligence Enterprise Edition deployment is completed.

Enabling the Auto Complete Feature on Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1

To enable auto complete feature on Oracle Business Intelligence Enterprise Edition, perform the 
following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services. 

Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for the detailed instructions on how to start, stop admin server, managed server 
and opmn services.

2. Login to analytics (http://<Server>:<port>/analytics).

3. Click on the WebLogic User (top-most-right section of the page). 

4. From the drop-down menu, select My Account. 

5. Set Prompt Auto Complete to ON, and click OK. 
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Chapter 4 
Upgrading Oracle Utilities Analytics

This chapter provides an overview of upgrading Oracle Utilities Analytics v2.5.2.0.1 from an 
earlier version:

• Supported Upgrade Paths

• Upgrading Oracle Utilities Analytics

Supported Upgrade Paths
The direct upgrade to Oracle Utilities Analytics v2.5.2.0.1 is supported from Oracle Utilities 
Analytics v2.5.0.0.4.

Important Note: For upgrading from a version not supported by direct 
upgrade path, the product must be first upgraded to Oracle Utilities Analytics 
v2.5.0.0.4, and then upgraded to Oracle Utilities Analytics v2.5.2.0.1.

Upgrading Oracle Utilities Analytics
Note: Ensure to install jdk_1.6.0_35, Weblogic 10.3.6 and Oracle Data 
Integrator 11.1.1.7.0 softwares on Oracle Utilities Analytics Application server 
if planning to register source application for the first time with Oracle Data 
Integrator based ETL.

To upgrade to Oracle Utilities Analytics v2.5.2.0.1, users must upgrade to Oracle Utilities Analytics 
v2.5.0.0.4 if it is on earlier version of product.

This section describes the procedure to upgrade to Oracle Utilities Analytics v2.5.2.0.1:

• Prerequisites

• Upgrading Oracle Utilities Analytics Database Component

• Upgrading Oracle Utilities Analytics Based ELT Component

• Upgrading Oracle Utilities Analytics Administration Tool Component

• Upgrading Oracle Utilities Analytics Dashboards Components

Prerequisites
The required prerequisites are based on the source applications you are using:

• Oracle Data Integrator Based Source Applications
(Oracle Utilities Customer Care and Billing, Oracle Utilities Operational Device 
Management)
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• Oracle Warehouse Builder Based Source Applications
(Oracle Utilities Mobile Workforce Management, Oracle Utilities Meter Data Management, 
Oracle Utilities Network Management System)

Oracle Data Integrator Based Source Applications
Note: Ensure to copy jdk_1.6.0_35 on Oracle Data Integrator server and 
Oracle Data Integrator 11.1.1.7.0 softwares on the Oracle Data Integrator 
server.

Note: Make sure that source applications are down and no one is 
accessing the source database. However, the source database must be up 
and running.

Perform the following steps as a part of prerequisites:

1. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the 
SQL mentioned below to get all the context codes.

2. Select CONTEXT_CD from the b1_prod_instance where CONTEXT_CD<>'B1';.

3. For each context returned by the query, perform the following steps:

a. Connect to the source database corresponding to context code with sys user and execute 
the following command:

alter system switch logfile
select SEQUENCE# from v$Log where STATUS='CURRENT';

b. Note down the result of the query mentioned above.

c. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute 
the SQL mentioned below:

Select DB_HOST,GG_HOME from b1_gg_cfg where 
GG_CFG_CD='<Context_code>' to get source GoldenGate server and 
Oracle GoldenGate home on source server.

d. Connect to the source GoldenGate server and log into the source Oracle GoldenGate 
prompt.

cd <GG_Home>
./ggsci

e. Execute the following command:

info extract <Context_codeXXX>,showch
For example, info extract CCB1AAX,showch

In the Recovery Checkpoint section, sequence should be equal or greater than one 
returned by “select SEQUENCE# from v$Log where STATUS='CURRENT'”query.

For example,

Repeat the check mentioned in the step e for each extract process.

f. Also make sure that the pump processes transfer all the changes to the target server. Lag 
at the Chkpt and Time Since Chkpt should look as shown below.
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For example,

g. On the source database server, drop all the GoldenGate processes by following these 
steps:

Connect to the MDADM schema of the Oracle Utilities Analytics database and execute 
the following query to get GoldenGate Owner name in the source database.

select SCHEMA_NAME

from MDADM.B1_CONTEXT_CFG_VW

where LSCHEMA_NAME = 'Journal'

and CONTEXT_CD = '<Context_code>';

Login to source GoldenGate prompt.

cd <GG_Home>

./ggsci

Execute the following commands:

dblogin userid < GoldenGate Owner >,PASSWORD < GoldenGate Owner password>

stop <Context_code>*

For example: 

stop CCB1*

delete <Context_code>*

For example:

delete CCB1*

Stop mgr

h. Connect to the sys user of the source database server and execute the following 
command: 

<GG_Home>/ddl_disable.sql

i. Rename the existing source GG Home on the source server. Remember to note down 
the GoldenGate manager port number and source GoldenGate home before 
renaming it.

For example, mv <GG_Home> <GG_Home>.bkp

j. On the Oracle Utilities Analytics database server, make sure the replicate processes apply 
all changes for the context code.

• Connect to the MDADM schema of the Oracle Utilities Analytics database and 
execute below to get target server and GoldenGate Home on the target server.

select DB_HOST,GG_HOME from b1_gg_cfg where GG_CFG_CD='B1';
• Connect to the target server and login to the GoldenGate prompt. 
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Execute the following commands:

cd <GG_Home >

./ggsci
Dblogin userid MDADM,password <MDADM user password>
Send replicat <Context_codeXX>,status

The current status will be at EOF as shown below in the screenshot.

• Check this for each replicat process for the context code.

• After checking the current status, each replicat process for the context code, execute 
the following commands:

Stop <Context_code>*

For example:

stop CCB1*

Delete <Context_code>*

For example:

delete CCB1*

4. After all source applications changes have been synced in the Oracle Utilities Analytics 
database, execute the following command after connecting to the target GoldenGate Home 
prompt.

./ggsci
Stop mgr

5. Rename the existing target GoldenGate Home directory and remember to note down the 
GoldenGate manager port number and target GoldenGate home before renaming it.
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6. Stop BI_RUN_ALL by performing the steps mentioned below: 
Login to Oracle Database Integrator Studio. Double click on Global/WLS_AGENT and 
select Inactive Radio button and save the changes.

Go to the Topology tab. Right -click on the OracleDIAgent and select the Upgrade 
Schedule option.
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7. Check all the jobs are completed by executing the following query after connecting the Oracle 
Utilities Analytics database. Note that this is applicable if the source system is Oracle Utilities 
Customer Care Billing / Oracle Utilities Operational Device Management. 

SELECT
  *
FROM mdadm.b1_jobs_vw
WHERE status_flg NOT IN ('D', 'E', 'RP');

Note: No rows should be returned from the query mentioned above. If any 
rows are returned, that means jobs are not yet completed.

8. Stop the Oracle Data Integrator admin and managed servers.

9. Upgrade Oracle Data Integrator software on Oracle Data Integrator server.

a. Take a backup of existing Oracle Data Integrator 11.1.1.6.0 Middleware home.

b. Install Oracle Data Integrator 11.1.1.7.0 and provide JDK as jdk_1.6.0_35 and 
Middleware home as Middleware home, which was used by Oracle Data Integrator 
11.1.1.6.0. Also, skip the repository creation step while installing Oracle Data Integrator 
11.1.1.7.0.

c. Navigate to $ORACLE_ODI_HOME/bin and execute the following command:

./ua

d. Oracle Fusion Middleware Upgrade Assistant tool opens up. Go to Oracle Data 
Integrator Repository page, select the Upgrade Oracle Data Integrator 
Repositories option and click Next.
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e. Enter all the required details and click Next.

Oracle Warehouse Builder Based Source Applications
If you have Oracle Warehouse Builder based source application (Oracle Utilities Mobile 
Workforce Management, Oracle Utilities Network Management System and Oracle Utilities 
MDM), bring them down to make sure no one is accessing the application(s).

Note: You must upgrade Oracle Warehouse Builder based source 
applications to a version, which support Oracle Utilities Analytics 
v2.5.2.0.1. And, you must upgrade the source database to v12.1.0.2.

Here are the steps to be followed: 

1. Generate final extract from the source application and upload to the warehouse.

2. Complete all the source side configurations. 

Note: For more information on the Source Side Configuration details, refer to 
the Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities 
Analytics Administration Guide.

3. Install Oracle GoldenGate on the source GoldenGate server. Make sure that the database 
location is as per requirement at the time of GoldenGate installation.

Note: Ensure that you remember the GoldenGate Home and 
GoldenGate Manager Process Port Number.

4. Go to the GoldenGate home location and execute the following command:

cd <GG_Home>
mkdir diroby

5. Keep the source database is in the archivelog mode.

6. Connect to source database with sys user and execute the following command.

alter database add supplemental log data (primary key) columns

7. Set enable_goldengate_replication parameter in database to true.

8. Create the new tablespace in the source database.

9. Create a database user in the source database, which will be the GoldenGate Owner in the 
source database and assign the created tablespace as a default tablespace to this user.
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10. Connect to the source database with sys user and execute the following commands: 

Note: Make sure to change GoldenGate owner placeholder with actual name 
of database user as created in previous step.

grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate 
Owner>;
grant unlimited tablespace to <GoldenGate owner> with admin option;
EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate 
Owner>','capture');
grant unlimited tablespace to <GoldenGate Owner> with admin option;
Revoke dba from <GoldenGate Owner>;
grant create any view to <GoldenGate Owner>;
grant select any dictionary to <GoldenGate Owner>;
GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;

If the source application Oracle Utilities Meter Data Management, then execute the query 
mentioned below:

Grant select on <application ADM Schema>.F1_MST_CONFIG to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to 
<GoldenGate Owner>;

11. Execute Oracle GoldenGate scripts.

cd <GG_Home>
./ggsci
create subdirs

12. Connect to sys user and execute the following commands.

cd <GG_Home>
@marker_setup.sql
@ddl_setup.sql
@role_setup.sql
grant GGS_GGSUSER_ROLE to <GoldenGate owner>;

13. Execute the following commands:

Note: The following pre-requisite steps are to be executed before running the 
OUA installer. Refer to the Oracle GoldenGate Administering Oracle GoldenGate 
Guide for more info.

Configuration for Encrypting Data with the ENCKEYS Method

a. Execute the following command:

cd $OGG_HOME
./KEYGEN key_length n

The above command generates the key value based on the value specified in the 
parameter "n". The key value has to be copied to ENCKEYS file against a logical name.

b. For each key value generated above, provide a logical name (Logical name should not be 
the same for two different key values). Enter the logical name space and then key value in 
the ENCKEYS file. 

c. Repeat the step above for each key values generated. 

d. Save the file with name ENCKEYS (Upper case only) without any extension.

Example: 
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cd $OGG_HOME
./keygen 128 1
0x8CE55035DD6893205A7BD6773FA8E670

e. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an 
existing ENCKEYS text file to append.

bash-4.1$ vi ENCKEYS

f. Input the Logical name, space and key value generated.

bash-4.1$ cat ENCKEYS
CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
bash-4.1$

g. The source ENCKEYS file entry has to be appended to the intermediate server or target 
server which would be configured with the source system where target OGG is being 
configured.

Note: It is recommended to name Logical key name after 
<context_code>KEY. For example: if context code is CCB1, it is 
recommended to name CCB1KEY.

Generating the shared secret password

a. Execute the following command:

cd $OGG_HOME
./ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY 

<key_name>

Example:

cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY 

CCB1KEY
Encrypted password: 

AADAAAAAAAAAAAIAVGNHBFLGFCHBTCVBFJFHUEJGNCFAOAFEOFBALELISFOEIFWGRBZHCC
MCYGYBDAZH

Algorithm used: AES128

b. Note down the above generated ENCKEYS file Logical name/key value, algorithm 
name used and the generated Encrypted password.

c. This information will be required while configuring the source. Please refer to the Admin 
Guide for instructions on source configuration.

Upgrading Oracle Utilities Analytics Database Component
Note: Upgrade the Oracle Utilities Analytics database to 12.1.0.2 version, 
ignore if the Oracle Utilities Analytics database is already on 12c version.

Note: Upgrade the Oracle Utilities Analytics Database component on the 
Oracle Utilities Analytics database server.

Note: Install 12.1.2.1 version of Oracle GoldenGate on the Oracle Utilities 
Analytics database server under the same directory where the older 
version of Oracle GoldenGate was installed and start the manager 
process on the same port. Remember the step 5 of the section 
Prerequisites. This is applicable only if the source application is using Oracle 
Data Integrator based ELT.
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This section describes how to upgrade the database component of Oracle Utilities Analytics 
v2.5.2.0.1. It includes the following topics:

• Copying and Decompressing the Install Media

• Creating the Users and the Tablespaces

• Installing the RELADM Schema

• Installing the MDADM Schema

• Installing the DWADM Schema

• Configuring the Spatial Data

Copying and Decompressing the Install Media
To copy and decompress the install media, perform these steps:

1. Download Oracle Utilities Analytics version 2.5.2.0.1 Oracle Database part (Oracle Utilities 
Analytics V2.5.2.0.1 Oracle Database Multiplatform.zip) from the Oracle Software 
Delivery Cloud (https:// edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp for a Windows machine or /OUA/temp 
for a Linux machine. This directory (referred as <TEMPDIR> below) must be located 
outside any current working Oracle Utilities application environment. All files that are placed 
in this directory as a part of the installation, can be deleted after completing a successful 
installation.

3. Unzip Oracle Utilities Analytics V2.5.2.0.1 Oracle Database Multiplatform.zip to 
<TEMPDIR> using any zip utility.

Creating the Users and the Tablespaces 
1. Ensure to create users in the database with the following names without giving specific roles 

if these do not exist already: 
DWADM, DWUSER, DWREAD, MDADM, RELADM, MASTER_REPO, WORK_REPO 
and DWSTAGE

2. Connect to the sys user and revoke the DBA privilege from the following users if the DBA 
privilege has been granted to them:
DWADM,MDADM,RELADM,MASTER_REPO,WORK_REPO AND DWSTAGE

3. Ensure to create roles with the following names if these do not exist already: 
DW_USER, DW_READ, DW_REPLICATE and DW_PRIVS_ROLE.

4. Connect to the sys user, execute the Usersgrants.sql in /Scripts/Usersgrants.sql. This SQL 
provides the required grants to the created users.

5. Copy the DuplicateRecordCheck.sql file from the BI252\DWADM\Pre-Installation 
directory to the database server under ../<Temp> directory.

6. Connect to the DWADM schema and execute the ../<Temp>/DuplicateRecordCheck.sql.

Note: If it displays no rows selected, it is good to proceed. If it displays some 
data, then contact support team and do not proceed with the installation. It is 
recommended to wait until you get the data fix script.

Installing the RELADM Schema 
The RELADM schema is a metadata schema that consists of the database objects used for storing 
the product version and component installation information.

This section describes initial installation of the RELADM schema, including:

• Reviewing the Storage.par file

• Installation Steps
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• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. Provide the value: RELADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• The location for jar files (the Jar files are bundled with the database package in 
BI252\RELADM\Jarfiles).

• Java Home (for example: C:\Java\jdk1.6.0_20).

Reviewing the Storage.par file
The storage.par file (that comes with the product and is in location ..\BI252\RELADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that Oracle database server uses to access a table or 
to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the RELADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
Storage.par file to indicate the correct tablespace name on which 
RELADM has quota.

Installation Steps
Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 12c 32 bit client and the Java Development Kit 
Version 6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle 
client is updated with the entry for the target database to connect to the target 
database.

Perform the following steps to install the RELADM schema:

1. Run the CDXDBI.exe from ..\BI252\RELADM\Install-Upgrade. Run the utility from the 
command prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database: <DB NAME>.

• The password for the system user account in the database (in silent mode).

• The name of the owner of the database schema: RELADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI252\RELADM\Jarfiles>.

• The password for the user (in silent mode): <RELADM user password>.
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• The Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle user with the read-only privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• The Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates the RELADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing the MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing 
the metadata of Oracle Utilities Analytics. For example, ETL job execution status, target tables for 
ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including: 

• Reviewing the Storage.par file

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. Provide value: MDADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. There is no need to provide any value here, just press Enter to proceed.

• A user with the read-only privileges to the objects in the application schema. There is no need 
to provide any value here, just press Enter to proceed.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. There is no need to provide any value here, just press Enter to 
proceed.

• A database role with the read-only privileges to the objects in the application schema. There is 
no need to provide any value here, just press Enter to proceed.

• The location for jar files (the Jar files are bundled with the database package in 
BI252\MDADM\Jarfiles).

• Java Home (for example: C:\Java\jdk1.6.0_20).

Reviewing the Storage.par file
The storage.par file (that comes with the product and is in location ..\BI252\MDADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
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reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a table 
or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the MDADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
Storage.par file to indicate the correct tablespace name on which 
MDADM has quota.

Installation Steps
Perform the following steps to install the MDADM schema:

Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 12c 32 bit client and Java Development Kit Version 
6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle client is 
updated with the entry for the target database to connect to the target database.

1. Run the CDXDBI.exe from ..\BI252\MDADM\Install-Upgrade. Run the utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database:<DB NAME>.

• The password for the system user account in the database (in silent mode).

• The name of the owner of the Database Schema: MDADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI252\MDADM\Jarfiles>.

• The password for the user (in silent mode).

• The Oracle user with the read-write privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle user with the read-only privileges to the database schema: No input needed. 
Press Enter and continue.

• The Oracle database role with the read-write privileges to the database schema: No input 
needed. Press Enter and continue.

• The Oracle database role with the read-only privileges to the database schema: No input 
needed. Press Enter and continue.

2. The utility creates the MDADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

Installing the DWADM Schema 
The DWADM schema contains the star schema objects such as facts and dimensions that contain 
all the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:
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• Executing Pre-installation SQL

• Connect to the DWADM schema and execute the PreIndexCreation.sql.

• Installation Steps

• Installation Steps

• Generating the Database Statistics

The process prompts you for the names of three database users:

• A user that owns the application schema. For example, DWADM.

• A user that has the read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER.

• A user with the read-only privileges to the objects in the application schema. For example, 
DWREAD.

The process also prompts you for the following:

• A database role that has the read-write (select/update/insert/delete) privileges to the objects 
in the application schema. For example: DW_USER. The application will access the database 
as DW_USER.

• A database role with the read-only privileges to the objects in the application schema. For 
example, DW_READ.

• The location for jar files (the Jar files are bundled with the database package in 
BI252\DWADM\Jarfiles).

• Java Home (for example: C:\Java\jdk1.6.0_20).

Executing Pre-installation SQL
Copy the …\Pre-Installation\PreInstallAddColumns.sql and …\Pre-Installation 
\PreIndexCreation.sql scripts to the database server under ../<Temp> directory.

• Change the current directory to ../<Temp>.

• Connect to the DWADM schema and execute the PreInstallAddColumns.sql.

• Connect to the DWADM schema and execute the PreIndexCreation.sql.

Reviewing the Storage.par file
The storage.par file (that comes with the product and is in location ..\BI252\DWADM\Install-
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you 
decide to allocate some tables or indexes outside of the default tablespace, then this has to be 
reflected in the storage.par file by changing the tablespace name from the default value to a 
custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle database server uses to access a table 
or to create an index. The default value is 1.

Note: If database does not have CISTS_01 tablespace or the DWADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
Storage.par file to indicate the correct tablespace name on which 
DWADM has quota.
Upgrading Oracle Utilities Analytics 4-14 
Oracle Utilities Analytics Installation Guide 



Installation Steps
Perform the following steps to install the DWADM schema:

Note: Ensure to run the CDXDBI.exe (in the step below) from a Windows 
desktop that has the Oracle 12c 32 bit client and Java Development Kit Version 
6.0 Update 20 or later. Ensure that the tnsnames.ora file of the Oracle client is 
updated with the entry for the target database to connect to the target database.

1. Run the CDXDBI.exe from ..\BI252\DWADM\Install-Upgrade. Run the utility from the 
Command Prompt. The utility prompts you to enter values for the following parameters:

• The name of the target database: <DB NAME>.

• The password for the system user account in the database (in silent mode).

• The name of the owner of the Database Schema: DWADM.

• The location of Java Home: <..\jdk1.6.0_20>.

• The location of TUGBU Jar files: <..\BI252\DWADM\Jarfiles>.

• The password for the user (in silent mode).

• The Oracle user with the read-write privileges to the database schema: DWUSER.

• The Oracle user with the read-only privileges to the database schema: DWREAD.

• The Oracle database role with the read-write privileges to the database schema: 
DW_USER.

• The Oracle database role with the read-only privileges to the database schema: 
DW_READ.

2. If you choose to continue, the CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace if 
they do not exist.

3. After setting up roles and users, the utility continues installing schema and system data 
definitions. 
If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Postinstallation Steps
Connect to the DWADM schema of the Oracle Utilities Analytics database and execute the 
following:

...\BI252\DWADM\Post-Upgrade\ControlZoneUpdate.sql

Connect to the Oracle Utilities Analytics database with the system user and execute the script 
mentioned below:

…/BI252\DWADM\Post-Upgrade\DataCorrection2511.sql

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');

Configuring the Spatial Data
Refer to the Chapter 6: Spatial Configuration for the details regarding the spatial configuration.
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Upgrading Oracle Utilities Analytics Based ELT Component
Note: Upgrade the Oracle Utilities Analytics Based ELT component on the 
Oracle Utilities Analytics application server.

This section describes how to upgrade the ELT component of Oracle Utilities Analytics. It 
includes the following topics:

• Prerequisites

• Copying and Decompressing the Install Media

• Starting the Installer

• Upgrade Steps

• Post-Upgrade Tasks

• Configuring Source Applications

Prerequisites 
Perform these steps before upgrading Oracle Utilities Analytics:

1. Connect to the MDADM schema and execute "select max(global_cfg_id) from 
b1_global_cfg;” to get the maximum value

2. Advance the B1_GLOBAL_CFG_SEQ sequence in the MDADM schema to value returned 
by the previous query.

3. Login to Oracle Data Integrator Studio. Go to Designer tab. Go to Load Plans and 
Scenarios. Select all the scenarios, except Accelerators and Framework folder. Right-click 
and click on Delete. 
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4. Go to Designer tab > Projects. Right-click on Oracle Utilities BI Project and click Delete 
option.

Copying and Decompressing the Install Media
To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.5.2.0.1 Multiplatform part (Oracle 
Utilities Analytics V2.5.2.0.1 Multiplatform.zip) from the Oracle Software Delivery Cloud 
(https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.5.2.0.1 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
Go to the temporary folder where you have downloaded the installer and run the following 
command from this folder:

java -jar <TEMPDIR>/OUA_2.5.2.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.7. 
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The Welcome page appears. Review this information before you begin the installation and click 
Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each 
item in the navigation pane represents a specific installer screen that will prompt you for 
information required to install the software.

Upgrade Steps
To install Oracle Data Integrator Based ETL, perform the following steps

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this 
information before you begin the installation and click Next to continue with the installation.

2. The Installation Location page appears. Define the Installation Location and click Next.

3. The Select Installation Type page appears. In the Select Installation Type page, select 
ODI Based ETL and click Next.

Note: Based on the selected installation type, the options on the left navigation panel 
changes. When you select Oracle Data Integrator Based ETL as an Installation Type, 
you need to define Database and Java Home Details, Target Database Connection 
Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator 
Agent and Repository Details and Target GoldenGate Details.

4. The Database and Java Home Details page appears. Enter the following details in the 
respective fields and click Next.

Field Name Description Value

Database Client Home This is the database client 
home location.

Example: /u01/app/product/
12.1.0/dbhome_1

Java Home This is the JDK home loca-
tion.

Provide location of JDK 1.6 
(1.6.0_35+)
Example: /u01/jdk_1.6.0_35
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5. The Target Database Connection Details page appears. Enter the following details in the 
respective fields and click Next:

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

6. The ODI Home and Schema Details page. Enter the following details in the respective 
fields and click Next:

Field Name Description Value

Weblogic Home The directory where 
WebLogic to be used for 
Oracle Data Integrator has 
been installed.

Example:
/u01/Middleware/wlserver_10.3

ODI Home The directory where Oracle 
Data Integrator (ODI) has 
been installed.

Example:
/u01/Middleware/Oracle_ODI1

Supervisor User The name of the Oracle Data 
Integrator Supervisor.

SUPERVISOR 

Supervisor Password The password of the Oracle 
Data Integrator Supervisor.

SUPERVISOR user password

Confirm Supervisor 
Password

Confirm the password of the 
Supervisor here.

Master Repository 
Schema Name

Oracle Data Integrator master 
repository schema name.

MASTER_REPO

Master Repository 
Schema Password

The password of the master 
repository schema.

MASTER_REPO user's 
password

Confirm Master 
Repository Schema 
Password

Confirm the password of the 
Oracle Data Integrator master 
repository schema here.
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7. The ODI Agent and Details page appears. Enter the following details in the respective 
fields and click Next:

Field Name Description Value

ODI Agent Host The host on which Oracle 
Data Integrator WebLogic 
Domain is created.

It is Oracle Data Integrator 
Server host name.

ODI Agent Port The port on which Oracle 
Data Integrator WebLogic 
agent is configured to run. 
This is the port of Oracle 
Data Integrator WebLogic 
Managed Server Port.

Provide available port and make 
sure to use the same port while 
creating Oracle Data Integrator 
managed server.

Master Repository ID Oracle Data Integrator Master 
Repository ID.

The default value is 601.

Work Repository ID Oracle Data Integrator work 
Repository ID. 

The default value is 602.

8. The Target GoldenGate Details page appears. Enter the following details in the respective 
fields and click Next:

Work Repository 
Schema Name

Oracle Data Integrator work 
repository schema name.

WORK_REPO

Work Repository 
Schema Password

The password of the work 
repository schema.

WORK_REPO user's password

Confirm Work 
Repository Schema 
Password

Confirm the password of the 
Oracle Data Integrator work 
repository schema here.

Field Name Description Value

GoldenGate Host The host on the Oracle 
GoldenGate Manager.

GoldenGate Home This is the Oracle 
GoldenGate installed 
location. 

Example: /opt/local/
ggs_12.1.2.0.0

Target Database Home This is the database home 
installed location on the target 
database server. 
In case GoldenGate for target 
is not installed on the OUA 
database server, provide 
oracle client home location on 
the server on which 
GoldenGate is installed.

Example: /u00/oracle/app/
oracle/product/11.2.0/
dbhome_1

Field Name Description Value
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9. The Add Cistab Entry page appears.

10. Register the installed Oracle Utilities Analytics environment in the /etc/cistab file for Unix 
based Operating systems and in the C:\spl\etc\cistab file for Windows Operating system. 
The cistab file needs to be created in the specified location if it does not already exist. Copy 
the text shown, add the text in a new line in the cistab file and save the file. Click Next.

11. The Installation Summary page appears. Verify the installation options you selected.

12. Click Install to begin the installation. 

If you want to make any changes to the configuration before starting the installation, use the 
navigation pane and select the topic you want to edit.

13. The Installation Progress page appears which allows you to see the progress of the 
installation. Operations being performed as a part of the installation are logged to the 
terminal from which the installer was run. The Detailed logs of the installation are also 
available in the logs/system directory under the installation location.

If you want to quit before the installation is completed, click Cancel. Doing so will result in a 
partial installation; the portion of the software that was installed on your system before you 
click Cancel will remain on your system, and you will have to remove it manually.

14. In the Installation Completed page, click Finish to dismiss the installer.

The Oracle Data Integrator based ETL is now installed.

GoldenGate Manager 
Port

The port number on which 
Oracle GoldenGate Manager 
is running on the GoldenGate 
host.

The default value is 7830

GoldenGate Dynamic 
Min Port

This is the dynamic minimum 
port configured in Oracle 
GoldenGate.

Provide the start range value set 
for the target GoldenGate 
manager process. The default 
value is 7830.

GoldenGate Dynamic 
Max Port

This is the dynamic maximum 
port configured in Oracle 
GoldenGate on the target 
database server.

Provide the end range value set 
for the target GoldenGate 
manager process. The default 
value is 7880.

GoldenGate Algorithm This is the algorithm 
configured in Oracle 
GoldenGate on the target 
database server.

The default value is 1.

GoldenGate 
Encryptkey

This is the Encrypt Key 
configured in Oracle 
GoldenGate on the target 
database server. 

The default value is 
“DEFAULT”.

GoldenGate Shared 
Secret

This is shared secret key 
configured in Oracle 
GoldenGate on the target 
database server. The default 
value is"DEFAULT”.

Go to the Oracle GoldenGate 
prompt and run the command: 
encrypt password <password of 
MDADM user>, encryptkey 
DEFAULT 
Provide the result of above 
command as the value.

Field Name Description Value
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Post-Upgrade Tasks
Perform the following steps:

1. Login to Oracle Data Integrator Client.

1. Navigate to Topology > Contexts.

2. Double-click on each context, except Global.

3. Navigate to Schemas tab. 
Check if the staging logical schema is mapped to the B1.DWSTAGE physical schema. 
If staging logical schema is not mapped, then map it to the B1.DWSTAGE, and click on 
some other mapping and click Save. 
Close and reopen to verify that the mapping has been saved.
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4. Login to Oracle Data Integrator Studio. Go to Designer tab. Navigate to Load Plans and 
Scenarios > Framework > Data Fix. Right click on B1_MDFIX_2_5_2 and select 
Execute.
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5. Login to Oracle Data Integrator Studio. Go to Designer tab. Navigate to Load Plans and 
Scenarios > Framework > Data Fix. Right-click on B1_CLEANUP_STAG and select 
Execute option.
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6. Connect to the DWSATGE schema of the Oracle Utilities Analytics database and drop the 
tables mentioned below if these exist:

ERR_CF_PAY_PLAN 
ERR_CF_PA_SNAP 
ERR_CF_FT_GL 
ERR_CF_PAY_PLAN_SNAP 
ERR_CF_SA_BILLING 
ERR_CF_PA 
ERR_CF_CASE 
ERR_CF_CASE_LOG 
ERR_CF_FT 
ERR_CF_COLL_EVT 
ERR_CF_TD_ENTRY 
ERR_CF_RECENT_TD_ENTRY 

Configuring Source Applications
To configure source applications such as Oracle Utilities Meter Data Management, Oracle Utilities 
Mobile Workforce Management, Oracle Utilities Network Management System, which were 
earlier configured with Oracle Warehouse Builder, refer to section Configuring Source in the 
Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration 
Guide.

For the other source applications, such as Oracle Utilities Customer Care Billing, Oracle Utilities 
Operational Device Management, which were earlier configured with Oracle Data Integrator, 
perform the following steps mentioned in the below sections:

• Prerequisites

• Configuration Steps

Prerequisites
1. Install the minimum database supported version as required.

Note: For Oracle Utilities Customer Care Billing source application, the 
minimum database supported version is 11.2.0.3 +14551959 database patch.

Note: For Oracle Utilities Operational Device Management source application, 
the minimum database supported version is 12.1.0.2.

2. Install 12.1.2.1 version of Oracle GoldenGate on the source database server under the same 
directory where older version of Oracle GoldenGate was installed and make sure to start 
manager process at same port number. Remember the step i of the section Prerequisites.

Go to GG_Home directory and perform the steps mentioned below:

mkdir diroby

Login to GoldenGate prompt and execute the command mentioned below:

create subdirs

Execute the following commands after connecting to source database with sys user:

@marker_setup.sql
@ddl_setup.sql
@role_setup.sql
grant GGS_GGSUSER_ROLE to <GoldenGate Owner>

grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate 
Owner>;
grant unlimited tablespace to <GoldenGate Owner> with admin option;
EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate 
Owner>','capture');
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grant unlimited tablespace to <GoldenGate Owner> with admin option;
Revoke dba from <GoldenGate Owner>;
grant create any view to <GoldenGate Owner>;
grant select any dictionary to <GoldenGate Owner>;
GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
GRANT  EXP_FULL_DATABASE TO <GoldenGate Owner>;
GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;

Configuration Steps
To configure the source applications, perform the following steps:

1. Perform the steps for registering a source as described in the Registering a Source section 
in the Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics 
Administration Guide.

2. Stop the replicat processes of the source application(s) configured in the above steps on the 
target server.

3. Upgrade Oracle Utilities Customer Care Billing application to 2.4.0.2 level if the source 
application is Oracle Utilities Customer Care Billing.

4. Start the replicat process again which was stopped in the previous step and make sure that all 
the changes got applied to the Oracle Utilities Analytics database.

Note: Oracle Utilities Customer Care Billing replicat process gets stopped 
because of the DDL operation that is expected and you have to manually start 
Oracle Utilities Customer Care Billing replicat process multiple time to sync all 
the changes.

Execute the following commands:

cd <GG_Home >

./ggsci
Dblogin userid MDADM,password <MDADM user password>
Send replicat <Context_codeXX>,status

The current status will be at EOF as shown below in the screenshot.

Check this for each replicat process. 
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5. After replicat, apply all the changes, execute the sync context package for Oracle Utilities 
Customer Care Billing.
To execute B1_SYNC_CONTEXT package, login to Oracle Data Integrator Studio. Go to 
Designer. Navigate to Load Plans and Scenarios> Framework. Right-click on 
B1_SYNC_CONTEXT and select Execute option.

6. Select the context related to the source application, <no agent> as logical agent, and then 
click OK.

7. Set the Oracle Data Integrator environment and generate view for the source application by 
executing the following commands:

a. Connect to the RELADM schema and execute the following query : 
select server_name,env_dir from B1_INSTALL_COMPONENTS where 
comp_cd='BI_ODI'; to get the server and ODI environment directory details where 
ODI environment is set up.
Upgrading Oracle Utilities Analytics 4-27
Oracle Utilities Analytics Installation Guide



b.  cd <ODI environment directory>/etc and open the ENVIRON.INI file.
Value of the SPLENVIRON variable is the Oracle Data Integrator environment name. 
Note down the Oracle Data Integrator environment name.

c. cd <ODI environment directory>/bin and execute the command: ksh ./splenviron.sh -e 
<ODI environment name>

d. cd $SPLEBASE/bin

e. ksh ./runviewGenerator.sh -c <Context code>
Where context code is the source specific.

Upgrading Oracle Utilities Analytics Administration Tool Component
Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based 
configuration tool that can be used to configure Oracle Utilities Analytics. 

Note: Upgrade the Oracle Utilities Analytics Administration component on 
the Oracle Utilities Analytics database server.

This section describes how to install the Administration Tool for Oracle Utilities Analytics (OUA) 
configuration and change the default password of the Admin user, including:

• Upgrade Steps

• Changing the Default Password of the Admin User

Upgrade Steps
Perform the following step:

1. Download the patch 19595896 from My Oracle Support and copy to database server under 
the /temp directory.
Unzip the file as shown below:

cd /temp

Connect to the Oracle Utilities Analytics database with the sys user and execute the following 
command

a. EXEC DBMS_XDB.SETHTTPPORT(0);

b. SELECT DBMS_XDB.GETHTTPPORT FROM DUAL;

:This query should result value as zero(0) as shown in the screenshot given below:

c. ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;

d. ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;
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e. @apxpatch.sql

f. @apxldimg.sql  /temp/patch

g. @apex_rest_config.sql

You must remember the password for these two users, APEX_LISTENER user and 
APEX_REST_PUBLIC_USER

2. Import the Admin Tool for Oracle Data Integrator configuration:

a. Unzip the Oracle Utilities Analytics V2.5.2.0.1 Oracle Database Multiplatform.zip 
file. This file has a folder called AdminTool.

b. Create the ../AdminTool directory on the database server and copy the contents of the 
AdminTool directory (from the zip file) to this directory.

c. Go to the ../AdminTool directory, i.e., cd ../AdminTool.

d. Connect as the system user and execute the following scripts:

• Import application:
@DeployAdminApp.sql

• Deploy supporting objects:
@DeploySupportingObjects.sql

3. Download Apex 4.2.6 and copy to the server where you want to set up the Administration 
Tool under /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory.

Note: Create /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory if it 
does not exist.

4. Download Oracle Rest Data service and copy to the server where you want to set up the 
Administration Tool under /scratch/bi_oradata_01/Softwares/apex_listner directory.

Note: Create /scratch/bi_oradata_01/Softwares/apex_listner directory if it 
does not exist.

5.  Navigate to the scratch/bi_oradata_01/Softwares/apex_listner directory and unzip the file  
ords.3.0.0.121.10.23.zip.

cd /scratch/bi_oradata_01/Softwares/apex_listner

6. Navigate to the cd /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory and unzip the 
file apex_4.2.6_en.zip.

 cd /scratch/bi_oradata_01/Softwares/apex_4.2.6

7. Create a directory on the server for the Apex configuration. 
For example, mkdir/scratch/bi_oradata_01/apex_configuration

8. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory:

cd /scratch/bi_oradata_01/Softwares/apex_listner

9. Execute the following command:

java -jar ords.war install advanced

Note: Use JDK1.7 or later to execute.
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Note: You need to provide the required inputs as shown below:

10. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory:

cd /scratch/bi_oradata_01/Softwares/apex_listner

Execute the following command:

java -jar ords.war static /scratch/bi_oradata_01/Softwares/
apex_4.2.6/apex/images

Note: It creates i.war file.

11. Install Weblogic 10.3.6 with jdk 1.7.0+.

12. Create Weblogic domain.

Navigate to the <Middleware Home>/wlserver_10.3/commin/bin
cd <Middleware Home>/wlserver_10.3/commin/bin

Execute the following:
./config.sh
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a. Click Next. 

b. Provide the domain name and do not change the domain location. Click Next.
Upgrading Oracle Utilities Analytics 4-31
Oracle Utilities Analytics Installation Guide



c. Provide Weblogic User Password and make sure to remember it.

d. Select jdk1.7 and click Next.
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e. Select the Administration Server, Managed Servers, Clusters and Machines options 
as shown below: 

f. Provide Listen Port as available port and remember this port number. Click Next:
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g. Click Add and provide values as shown below:

h. Click Next.
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i. Click Next.

j. Click Next.

13. Create the boot.properties file.

14. Start the Admin and Managed server.
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15. Log into Weblogic console and click on Lock & Edit.

16. Click on Install.

17. Provide Path as: /scratch/bi_oradata_01/Softwares/apex_listner and select the ords.war file.

18. Click Next.
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19. Select the Apex Server option and click Next.

20. Select the options as shown below:
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21. Select the options as shown below:

22. Click Activate Changes.

23. Repeat the steps from 13 to 20 to deploy i.war file.

24. Login to Weblogic console and click on Deployment> Monitoring. Select i and ords. And 
then, click on Start and select Servicing All Requests option.
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25. Click Yes.

26. Restart the Admin and Managed servers.

27. Go to the following URL to access the Administration Tool:
http://<hostname>:<managed server port no>/ords/f?p=104

28. Credentials to access the Administration Tool:
User ID: Admin
Password: Admin_123

Changing the Default Password of the Admin User
The following APEX API can be used to change the password of the admin user. This script 
should be run after connecting to the database as user SYSTEM.

The string 'New password' should be replaced with the new password for the admin account 
before running the script. 

begin
  

wwv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_flow_a
pplication_install.get_workspace_id,2090606133849294));

end;
/

begin
apex_util.edit_user(
p_user_id      => '2090514487849294',
p_user_name => 'ADMIN',
p_web_password => 'New password',
p_new_password => 'New password'
);
end;
/

commit;
/

Important Note: It is strongly recommended that you should change the default password after 
logging in.
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Upgrading Oracle Utilities Analytics Dashboards Components
Note: Upgrade the Oracle Utilities Analytics Dashboards component on the 
Oracle Utilities Analytics application server.

Note: The patch 18818588 must be applied to Oracle Business 
Intelligence Enterprise Edition before installing the Oracle Utilities 
Analytics Dashboards.

This section describes how to install the dashboards component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing the Install Media

• Starting the Installer

• Upgrade Steps

• Deploying the Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying the MapViewer

• Post-deploying the Custom MapViewer

• Enabling WriteBack

• Enabling the Analytics Help

• Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

Copying and Decompressing the Install Media
To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics Dashboards component v2.5.2.0.1 (Oracle Utilities 
Analytics V2.5.2.0.1 Multiplatform.zip) from the Oracle Software Delivery Cloud (https:/
/edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.5.2.0.1 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
Go to the temporary folder where you have downloaded the install and run the following 
command from this folder:

java -jar <TEMPDIR>/OUA_2.5.2.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.7. 
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The Welcome page appears. Review this information before you begin the installation and click 
Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each 
item in the navigation pane represents a specific installer screen that will prompt you for 

information required to install the software.

Upgrade Steps
To install the Dashboards, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this 
information before you begin the installation and click Next to continue with the installation. 

2. The Installation Location page appears. Define the Installation Location here and click 
Next. 

3. The Select Installation Type page appears. In the Select Installation Type page, select 
Dashboards and click Next. 

4. The Database and Java Home Details page appears.Enter the following details in the 
respective fields and click Next.

Field Name Description Value

Database Client Home This is the database client 
home location.

Example: /u01/app/product/
12.1.0/dbhome_1

Java Home This is the JDK home loca-
tion.

Provide location of JDK 1.6 
(1.6.0_35+)
Example: /u01/jdk_1.6.0_35

5. The Target Database Connection Details page appears. Enter the following details in the 
respective fields and click Next:

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server
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6. The OBIEE Home Details page appears. Enter the following details in the respective fields 
and click Next:

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

Field Name Description Value

BI Home The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/ Middleware/
Oracle_BI1

BI Instance Home This is the instance home 
location under the location 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/Middleware/ 
instances/instance1

BI Domain Home This is the domain home 
location under the location 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/ Middleware/
user_projects/domains/
bifoundation_domain

Weblogic Host The hostname on which 
weblogic server for Oracle 
Business Intelligence 
Enterprise Edition is running.

Weblogic Port Number A unique port number within 
the system that is assigned to 
the HTTP port. This is the 
port number that is used as a 
part of the client URL request 
to connect to the host. This is 
Oracle Business Intelligence 
Enterprise Edition WebLogic 
console admin port number. 

Example: 7001

Field Name Description Value
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Note: You will be prompted for the Weblogic user’s password after installation, 
when configuring Oracle Utilities Analytics.

7. The Add Cistab Entry page appears.

8. Register the installed Oracle Utilities Analytics environment in the /etc/cistab file for Unix 
based Operating systems and in the C:\spl\etc\cistab file for Windows Operating system. 
The cistab file needs to be created in the specified location if it does not already exist. Copy 
the text shown, add the text in a new line in the cistab file and save the file. Click Next.

9. The Installation Summary page appears. Verify the installation options here.

10. Click Install to begin the installation. 

If you want to make any changes to the configuration before starting the installation, use the 
navigation pane and select the topic you want to edit.

11. The Installation Progress page appears which allows you to see the progress of the 
installation. Operations being performed as part of the installation are logged to the terminal 
from which the installer was run. Detailed logs of the installation are also available in the 
logs/system directory under the installation location.

If you want to quit before the installation is completed, click Cancel. Doing so will result in a 
partial installation; the portion of the software that was installed on your system before you 
click Cancel will remain on your system, and you will have to remove it manually.

12. In the Installation Completed page, click Finish to dismiss the installer.

The Dashboards component is now installed.

Deploying the Repository (RPD) File
If you have not made any changes to the deployed RPD, then take the RPD file from the following 
location: <install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd, where <install_dir> is the 
Oracle Utilities Analytics Dashboard Component installation directory.

If you have done merging, then take the merged RPD and make the required database changes.

This RPD file should be copied to the windows machine on which Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1 is installed.

Follow these steps to deploy the RPD file:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should be installed on the 
Windows machine before proceeding with the below steps.

2. Launch the Administration Tool from the Start menu.
Start > Programs > Oracle Business Intelligence > BI Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

Weblogic User WebLogic domain login user 
name. 

Field Name Description Value
Upgrading Oracle Utilities Analytics 4-43
Oracle Utilities Analytics Installation Guide



4. Provide the RPD password. The default password is "oracle123".

5. Edit the Connection Pools shown below by double-clicking on them.

6. In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following (only for MDM): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 
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9. In the MDM Database Connection group, provide the following (only for MDM): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

10. In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

12. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete.

13. Log into the Oracle Business Intelligence Enterprise Edition Enterprise Manager console.

14. Navigate to BI Instance > Coreapplication > Deployment.

15. Lock and edit.
The repository text box will be enabled.

16. Browse to the modified rpd file and submit. 

17. Provide the RPD password “oracle123”, and then click Apply.
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18. Activate the changes and then restart Oracle Utilities Analytics services.

Note: All the above-mentioned database sets of the connection pool should be 
updated in the tnsnames.ora file in <OBIEE_INSTALL_DIR>/
Oracle_BI1/network/admin.

Deploying the Web Catalog
To deploy the web catalogs, follow these steps: 

1. Go to the <Catalog location>/root/shared and delete the existing catalogs that were 
delivered out-of-box with the Oracle Utilities Analytics product in the previous release. Any 
catalog added by you can be retained. If Oracle Utilities Network Management System BI 
publisher reports were deployed, they should be retained. 

2. Go to <Catalog location>/root/system and remove spatialmetadata directory and 
spatialmetadata.atr file.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploycatalog.sh.

5. Enter the physical catalogs location configured in the Enterprise Manager. 
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd  %SPLEBASE%\bin.

4. deploycatalog.cmd.

5. Enter the Physical Catalogs location configured in the Enterprise Manager.
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

Configuring and Deploying the MapViewer
Configuring and deploying the MapViewer involves the following:

• Configuring the MapViewer

• Modifying the instanceconfig.xml

• Deploying the Custom MapViewer

Configuring the MapViewer
To configure Mapviewer, follow these steps: 

1. Log into the WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' datasource.
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3. Lock and edit.

4. Navigate to Services > Data Sources.

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS

JNDI Name = MAP_DS 

Database Type = oracle

6. Click Next.

7. Enter the following:
Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions 9.0.1 and later 

8. Click Next. 

9. Do not change any values on the next page and click Next.

10. Enter the following connection properties: 

• Database Name: BI Database Name 

• Host Name: Database host 

• Port: Database port

• Database User Name: dwadm

• Password: dwadm password

11. Click Next.

12. On the next page, click Test Configuration button. After the successful test, click Next 
again. 

13. The Select Target page opens. Now select AdminServer under Servers and bi_cluster under 
Clusters. Click Finish.

14. Click Activate Changes.

15. Update the mapViewerConfig file with the below-mentioned tags:

File location: <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/

mapviewer.ear/web.war/WEB-INF/conf/ 

File: mapViewerConfig.xml

16. If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node.

<proxy_enabled_hosts>
elocation.oracle.com
</proxy_enabled_hosts>

17. Add the following ns_data_provider node:

<ns_data_provider id="obieeNsdp" 
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

18. Add the current map_tile_server with the following map_tile_server node:

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>
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Modifying the instanceconfig.xml
Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesCo mponent\coreapplication_obips1

Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>
3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>

Deploying the Custom MapViewer
Note: The custom MapViewer is required to integrate weather information 
into Outage Analytics.

To deploy the custom MapViewer, follow these steps: 

For UNIX: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploymapviewer.sh.
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5. Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run deploymapviewer.cmd.

5. Enter WebLogic Domain Console password. For example, weblogic123.

Post-deploying the Custom MapViewer
Perform the following steps after deploying the custom MapViewer:

1. Log into the MapViewer: http://<Server>:<port>/mapviewer.

2. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration. Login to the Mapviewer at this location: http://
<HOST>:<MANAGERPORT>/mapviewer

3. Add the below content in the mapViewerConfig.xml with the appropriate values:

<map_data_source name="MAPCONN"
jdbc_host="<DB server name>"
jdbc_sid="//<DB Service name>"
jdbc_port="1521"
jdbc_user="DWADM"
jdbc_password="!<DWADM user password>" 
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"
/>

Note: The exclamatory mark in the front of the password ensures that the 
password is encrypted. 

4. Click Save, and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Enabling WriteBack
For enabling the Write Back, perform the following steps:

1.  Log into Analytics and navigate to Administration>Manage 
Privileges>WriteBack>Write Back to Database.

2. Click Denied:Authenticated User and select the permission Granted.

Enabling the Analytics Help
To enable the Analytics’ Help, perform these steps: 

1. Download Oracle Utilities Analytics v2.5.2.0.1 Getting Started Guide from Oracle Software 
Delivery Cloud (https:// edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics v2.5.2.0.1 Getting Started Guide, change the name of 
the OUA_Getting_Started_Guide_2.5.2.0.1.pdf file to OUASA Help.pdf.

3. Place the Help file in <install_dir>/Skin/res, where <install_dir> is the Oracle Utilities 
Analytics Dashboard Component installation directory.

4. Run the following commands: 
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For UNIX:
Perform the following steps: 

a. Navigate to <Install_Dir>/bin directory.

b. Initialize the environment with the ./splenviron.sh -e <envname> command.

c. cd $SPLEBASE/bin.

d. Run ksh ./deployanalyticsear.sh.

e. Enter the WebLogic Domain Console password. For example, weblogic123.

For Windows:

Perform the following steps: 

a. Navigate to <Install_Dir>/bin directory.

b. Initialize the environment with the ./splenviron.cmd -e <envname> command.

c. cd %SPLEBASE%/bin.

d. deployanalyticsear.cmd.

e. Enter the WebLogic Domain Console password. For example, weblogic123.

f. Restart the Oracle Utilities Analytics core services.

g. Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business 
Intelligence Enterprise Edition deployment is completed.

Enabling the Auto Complete Feature on Oracle Business Intelligence Enter-
prise Edition 11.1.1.7.1

To enable auto complete feature on Oracle Business Intelligence Enterprise Edition, perform the 
following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services. 

Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for the detailed instructions on how to start, stop admin server, managed server 
and opmn services.

2. Login to analytics (http://<Server>:<port>/analytics).

3. Click on the WebLogic User (top-most-right section of the page). 

4. From the drop-down menu, select My Account. 

5. Set Prompt Auto Complete to ON, and click OK. 
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Chapter 5 
Installing Demo Database

This chapter provides instructions for installing the demo database. 

Note: The demo installation does not support ETL functionality. The ETL 
Job Control dashboard accesses the Oracle Warehouse Builder and Oracle 
Data Integrator tables, and the demo dump does not have Oracle Warehouse 
Builder or Oracle Data Integrator objects. Hence, the ETL dashboard is not 
supported in the demo installation. 

The chapter includes the following topics: 

• Installing Oracle Utilities Analytics Demo Database Component

• Installing Oracle Utilities Analytics Dashboards Component

Installing Oracle Utilities Analytics Demo Database Component
This section describes how to install the demo component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing the Install Media

• Creating the Database and Importing the Dump File

• Configuring the Security

• Configuring the Spatial Data

Copying and Decompressing the Install Media
To copy and decompress the install media, follow these steps:

1. Download the Oracle Utilities Analytics V2.5.2.0.1 Demo Data part (Oracle Utilities 
Analytics V2.5.2.0.1 Demo Data.zip) from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

2. Create a temporary directory such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation, can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.5.2.0.1 Demo Data.zip to <TEMPDIR>. 
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Creating the Database and Importing the Dump File
This section describes how to create the demo database with AL32UTF8 character set using the 
database creation tool (cdxdba.plx for UNIX or CDXDBA.exe for Windows), including:

• UNIX Database Creation Utility

• Windows Database Creation Utility

• Importing Demo Data Manually

• Post-Import Tasks

Note: Ensure that Oracle Database Server Enterprise Edition 12.1.0.2.0 is 
already installed on the machine in order to create the database. 

Note: The UNIX and Windows database creation utilities creates an empty 
database with AL32UTF8 character set and at least one tablespace for storing 
the application objects before running the installation. The default name of the 
application tablespace is CISTS_01.

Note: If you get the following error messages while importing demo data, it is 
recommended to ignore:

ORA-31684: Object type USER:"MDADM" already exists
ORA-31684: Object type USER:"RELADM" already exists
ORA-31684: Object type USER:"DWADM" already exists

ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT EXECUTE ON "MDADM"."B1_TEXT_ARRAY" TO "CCB1REP"

ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT SELECT ON "MDADM"."B1_PROD_INSTANCE" TO "CCB1REP"
Job "SYSTEM"."SYS_IMPORT_SCHEMA_01" completed with 5 error(s) 

UNIX Database Creation Utility
The files are located in BI252/DatabaseCreation/Unix to create the database.

1. FTP the contents of the Database Creation folder to a temporary directory on the UNIX 
server.

2. To create the database, set the ORACLE_HOME and the ORACLE_BASE variables.

3. Execute the utility cdxdba.plx by executing the following command:
perl cdxdba.plx

4. Provide the following parameter values when the script prompts:

Instance name (DEMO): DEMO

ORACLE_BASE: The directory where the setup files for the database will be created (/
orasw/app/oracle):

ORACLE_HOME: The folder where the current version of Oracle software is installed (/
orasw/app/oracle/product/):

ORACLE_DATA: The directory where the data files for the database will be created (/db05/
oradata):

Character set for the database (AL32UTF8):
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5. Enter the values based on the settings of your database server. You can also accept the default 
values displayed if they match your database server settings. You will be prompted to confirm 
the settings and select Y or N to create the database.

ORACLE_SID: DEMO

ORACLE_HOME: /orasw/app/oracle/product/

ORACLE_BASE: /orasw/app/oracle

ORACLE_DATA: /db05/oradata

Character Set: AL32UTF8

Do you want to continue (Y/N)?

6. When the database has been created, you will be prompted with the following questions:

Do you want to import a demo database dump into this database (Y/N)?

Select Y to import the Demo Install data.

For the demo installation use the dump file exp_demo.dmp.

Do you want to import a demo database dump into this database (Y/N)? Y

Enter the name of the dump file (exp_demo.dmp):

Enter the name of the dump file directory (data_pump_dir):

Enter the name of the log file (exp_demo.log):

Note: The dump_dir must exist in the created database before continuing with the import. 
You should also copy the exp_demo.dmp file to the dump_dir. Uncompress the 
exp_demo.dmp.gz file first to extract the exp_demo.dmp file. This file is in ..\BI252\Demo 
directory.

Update the oratab file for the new database, and then check the connectivity to this database 
from another server and from your desktop after updating local tnsnames.ora file.

Windows Database Creation Utility
The files are located in ..\BI252\DatabaseCreation\Windows. You should be logged in as a user 
who is a member of local ORA_DBA group on that server. The ORA_DBA group should have 
“Administrator” privileges assigned to it.

1. To create a database, run the utility CDXDBA.exe located in the Windows folder from 
command prompt. The utility displays the following options:

E - Export a schema from the database

R - Refresh a schema with a database dump

C - Create/Recreate a local database

H - See help for the command line options

Q - Quit

2. Select the option C to create an empty database on your machine and provide the below 
inputs:

• Provide the instance name (DEMO): <DB Name> For example, BIDEMO.

• Enter the character set of the database (AL32UTF8): AL32UTF8.

• Enter ORACLE_BASE: The directory where the setup files for the database will be 
created (c:\oracle) : <Oracle_Base> For example, C:\app\oracle.
Installing Demo Database 5-3 
Oracle Utilities Analytics Installation Guide



• Enter ORACLE_HOME: The folder where the current version of Oracle software is 
installed (c:\oracle\product\11.1.0.6\Db_1):<Oracle_Home> For example, 
c:\app\oracle\db_home.

• Enter ORACLE_DATA: The directory where the data files for the database will be 
created (C:\app\oracle\oradata):<Directory where data files will be created>.

3. Once the database has been created, select the R - Refresh a schema option with a database 
dump file to load the demo install data.

• Select an option: R

• Enter the instance name (DEMO): <DB name>.

• Is it a LOCAL database (exists on the same machine) (Y/N): < provide Y or N>.

• Enter the name of the Oracle account that owns that application schema (spladm): 
DWADM.

• Enter the password for DWADM (spladm): DWADM.

• Enter the character set of the database (AL32UTF8): AL32UTF8.

• Enter the name of data pump directory (DATA_PUMP_DIR): DATA_PUMP_DIR.

• Enter the name of the dump file (expDWADM.dmp):exp_demo.dmp.

• Enter the name of the log file (impDWADM.log):exp_demo.log.

The option R causes the utility to drop all the objects from the schema and import the 
schema from a database dump file.

For the demo installation, use the exp_demo.dmp dump file.

Note: The dump_dir must exist in the database created above before 
continuing with the import. You should also copy the exp_demo.dmp file to 
the dump_dir. Uncompress the exp_demo.dmp.gz file to extract the 
exp_demo.dmp file. This file is in the ..\BI252\Demo directory.

Check the connectivity to this database from another server and from your desktop after 
updating the local tnsnames.ora file.

Importing Demo Data Manually
The demo data can also be imported by using the below command after successful database 
creation.

Note: Run this command from the database server:

Note: Make sure to change the tablespace_name to the tablespace name on 
which DWADM, RELADM and MDADM have the quota. If DWADM, 
RELADM and MDADM users have quota on cists_01 tablespace, then exclude 
whole remap_tablespace clause from the command.

1. Set the correct ORACLE_SID and ORACLE_HOME first, and then run below command to 
import demo dump.

impdp directory= dump_dir dumpfile= exp_demo.dmp logfile=    
exp_demo.log schemas=DWADM,RELADM,MDADM 
remap_tablespace=cists_01:<tablespace_name>

2. Provide the system as the user and system user's password when prompted.
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Post-Import Tasks
Connect to MDADM schema, and execute the below commands:

create public synonym B1_TARGET_ENTITY for B1_TARGET_ENTITY;
create public synonym B1_PROD_INSTANCE for B1_PROD_INSTANCE;
create public synonym B1_JOB_CONFIG for B1_JOB_CONFIG;

grant select on B1_TARGET_ENTITY to public;
grant select on B1_PROD_INSTANCE to public;
grant select on B1_JOB_CONFIG to public;

Configuring the Security 
For configuring the security, perform the following steps: 

1. Navigate to the ..\BI252\DWADM\Security folder.

2. Edit the file OraGenSec.bat, which is in the same location, and replace the parameter 
database-name with the name of your database. This file is provided for your convenience 
and executes the Oragensec.exe utility based on the parameters passed into it.

Note: Ensure to run OraGenSec.bat from a Windows desktop that has the 
Oracle 12c 32 bit client installed. Your database should already be listed in the 
local file tnsnames.ora.

The script executes as the following:

oragensec -d DWADM,<DWADM password>,database_name -r 
DW_READ,DW_USER - a A -u DWUSER,DWREAD

3. Execute the edited OraGenSec.bat file from the command prompt.

Configuring the Spatial Data
This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities 
Analytics. 

Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in the database and copy the user_sdo.dmp file from ../
BI252/Spatial-Metadata folder to that location.

2. Import the released spatial tables to the target database using the following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=
impdp_user_sdo.log schemas=DWADM
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from database server.

Note: Make sure to change the tablespace_name to tablespace name on which 
DWADM has the quota. If DWADM user have quota on cists_01 tablespace, 
then exclude whole remap_tablespace clause from command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts from the ../BI252/Spatial-Metadata 
folder:

- sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql

5. Review the log files.
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 Installing Oracle Utilities Analytics Dashboards Component
Note: Ensure that the same Operating System (OS) user is used to install the 
Oracle Utilities Analytics Dashboards component that is used to install all the 
prerequisite software. 

Note: Verify that the prerequisite software products mentioned in the section 
Prerequisite Software for Oracle Utilities Analytics Dashboards Component are 
installed.

Note: Install the Oracle Utilities Analytics Dashboards component on the 
Oracle Utilities Analytics application server.

This section describes how to install the dashboards component of Oracle Utilities Analytics. The 
section includes the following:

• Copying and Decompressing the Install Media

• Starting the Installer

• Installation Steps

• Deploying the Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying the MapViewer

• Post-deploying the Custom MapViewer

• Enabling WriteBack

• Enabling the Analytics Help

• Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 
11.1.1.7.1

Copying and Decompressing the Install Media
To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.5.2.0.1 ELT component based on Oracle 
Data Integrator part (Oracle Utilities Analytics V2.5.2.0.1 Oracle Database 
Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.5.2.0.1 Oracle Database Multiplatform.zip to 
<TEMPDIR>.

Starting the Installer
Go to the temporary folder where you have downloaded the install and run the following 
command from this folder:

java -jar <TEMPDIR>/OUA_2.5.2.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.7. 
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The Welcome page appears. Review this information before you begin the installation and click 
Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each 
item in the navigation pane represents a specific installer screen that will prompt you for 
information required to install the software.

Installation Steps
To install the Dashboards, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this 
information before you begin the installation and click Next to continue with the installation.

2. The Installation Location page appears. Define the Installation Location here and click 
Next. 

Note: The specified Oracle home directory must be an empty directory.

3. The Select Installation Type page appears. In the Select Installation Type page, select 
Dashboards and click Next. 

Note: Based on the selected installation type, the options on the left navigation panel 
changes. When you select Dashboard as an Installation Type, you need to define Database 
and Java Home Details, Target Database Connection Details and OBIEE Home 
Details.

4. The Database and Java Home Details page appears. Enter the following details in the 
respective fields and click Next.

Field Name Description Value

Database Client Home This is the database client 
home location.

Example: /u01/app/product/
12.1.0/dbhome_1

Java Home This is the JDK home loca-
tion.

Provide location of JDK 1.6 
(1.6.0_35+)
Example: /u01/jdk_1.6.0_35
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5. The Target Database Connection Details page appears. Enter the following details in the 
respective fields and click Next:

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

6. The OBIEE Home Details page appears. Enter the following details in the respective fields 
and click Next: 

Field Name Description Value

BI Home The location on the disk 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/ Middleware/
Oracle_BI1

BI Instance Home This is the instance home 
location under the location 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/Middleware/ 
instances/instance1

BI Domain Home This is the domain home 
location under the location 
where Oracle Business 
Intelligence Enterprise 
Edition software is installed.

Example: /u01/ Middleware/
user_projects/domains/
bifoundation_domain

Weblogic Host The hostname on which 
weblogic server for Oracle 
Business Intelligence 
Enterprise Edition is running.
Installing Demo Database 5-8 
Oracle Utilities Analytics Installation Guide



Note: You will be prompted for the Weblogic user’s password after installation, 
when configuring Oracle Utilities Analytics.

7. The Add Cistab Entry page appears.

8. Register the installed Oracle Utilities Analytics environment in the /etc/cistab file for Unix 
based Operating systems and in the C:\spl\etc\cistab file for Windows Operating system. 
The cistab file needs to be created in the specified location if it does not already exist. Copy 
the text shown, add the text in a new line in the cistab file and save the file. Click Next.

9. The Installation Summary page appears. Verify the installation options here.

10. Click Install to begin the installation. 

If you want to make any changes to the configuration before starting the installation, use the 
navigation pane and select the topic you want to edit.

11. The Installation Progress page appears which allows you to see the progress of the 
installation. Operations being performed as part of the installation are logged to the terminal 
from which the installer was run. Detailed logs of the installation are also available in the 
logs/system directory under the installation location.

If you want to quit before the installation is completed, click Cancel. Doing so will result in a 
partial installation; the portion of the software that was installed on your system before you 
click Cancel will remain on your system, and you will have to remove it manually.

12. In the Installation Completed page, click Finish to dismiss the installer.

The Dashboards component is now installed.

Deploying the Repository (RPD) File
If you have not made any changes to the deployed RPD, then take the RPD file from the following 
location: <install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd, where <install_dir> is the 
Oracle Utilities Analytics Dashboard component installation directory.

If you have done merging, then take the merged RPD and make the required database changes.

This RPD file should be copied to the windows machine on which Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1 (Install Oracle Business Intelligence Enterprise Edition 11.1.1.7.0 
and apply the patch 18818588) is installed.

Follow these steps to deploy the RPD file:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 should be installed on the 
Windows machine before proceeding with the below steps.

Weblogic Port Number A unique port number within 
the system that is assigned to 
the HTTP port. This is the 
port number that is used as a 
part of the client URL request 
to connect to the host. This is 
Oracle Business Intelligence 
Enterprise Edition WebLogic 
console admin port number. 

Example: 7001

Weblogic User WebLogic domain login user 
name. 

Field Name Description Value
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2. Launch the Administration Tool from the Start menu.
Start > Programs > Oracle Business Intelligence > BI Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is "oracle123".

5. Edit the Connection Pools shown below by double-clicking on them.

6. In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following (only for MDM): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD
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Password = DWREAD User password 

9. In the MDM Database Connection group, provide the following (only for MDM): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

10. In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

11. In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

12. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete.

13. Log into the Oracle Business Intelligence Enterprise Edition Enterprise Manager console.

14. Navigate to BI Instance > Coreapplication > Deployment.

15. Lock and edit.
The repository text box will be enabled.

16. Browse to the modified rpd file and submit. 
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17. Provide the RPD password “oracle123”, and then click Apply.

18. Activate the changes and then restart Oracle Utilities Analytics services.

Note: All the above-mentioned database sets of the connection pool should be 
updated in the tnsnames.ora file in <OBIEE_INSTALL_DIR>/
Oracle_BI1/network/admin.

Deploying the Web Catalog
To deploy the web catalogs, follow these steps: 

1. Go to the <Catalog location>/root/shared and delete the existing catalogs that were 
delivered out-of-box with the Oracle Utilities Analytics product in the previous release. Any 
catalog added by you can be retained. If Oracle Utilities Network Management System BI 
publisher reports were deployed, they should be retained. 

2. Go to <Catalog location>/root/system and remove spatialmetadata directory and 
spatialmetadata.atr file.

Note: Login to the Enterprise Manager, navigate to Coreapplication > 
Deployment >Repository for viewing the catalog location. At the bottom, 
you will see the catalog location.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploycatalog.sh.

5. Enter the physical catalogs location configured in the Enterprise Manager. 
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd  %SPLEBASE%\bin.

4. deploycatalog.cmd.

5. Enter the Physical Catalogs location configured in the Enterprise Manager.
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment 
>Repository for viewing the catalog location. At the bottom, you will see the catalog 
location.

Configuring and Deploying the MapViewer
Configuring and deploying the MapViewer involves the following:

• Configuring the MapViewer

• Modifying the instanceconfig.xml

• Deploying the Custom MapViewer

Configuring the MapViewer
To configure Mapviewer, follow these steps: 
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1. Log into the WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' datasource.

3. Lock and edit.

4. Navigate to Services > Data Sources.

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS

JNDI Name = MAP_DS 

Database Type = oracle

6. Click Next.

7. Enter the following:
Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions 9.0.1 and later 

8. Click Next. 

9. Do not change any values on the next page and click Next.

10. Enter the following connection properties: 

• Database Name: BI Database Name 

• Host Name: Database host 

• Port: Database port

• Database User Name: dwadm

• Password: dwadm password

11. Click Next.

12. On the next page, click Test Configuration button. After the successful test, click Next 
again. 

13. The Select Target page opens. Now select AdminServer under Servers and bi_cluster under 
Clusters. Click Finish.

14. Click Activate Changes.

15. Update the mapViewerConfig file with the below-mentioned tags:

File location: <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/

mapviewer.ear/web.war/WEB-INF/conf/ 

File: mapViewerConfig.xml

16. If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node.

<proxy_enabled_hosts>
elocation.oracle.com
</proxy_enabled_hosts>

17. Add the following ns_data_provider node:

<ns_data_provider id="obieeNsdp" 
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

18. Add the current map_tile_server with the following map_tile_server node:

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>
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Modifying the instanceconfig.xml
Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentatio
nServicesCo mponent\coreapplication_obips1

Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>
3. Add the following before the end tag </ServerInstance>:

<UI>
<DefaultStyle>oubi</DefaultStyle>
<DefaultSkin>oubi</DefaultSkin>
</UI>

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>

Deploying the Custom MapViewer
Note: The custom MapViewer is required to integrate weather information 
into Outage Analytics. 

To deploy the custom MapViewer, follow these steps: 

For UNIX: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.sh -e <envname> command.

3. cd $SPLEBASE/bin.

4. Run ksh ./deploymapviewer.sh.
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5. Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows: 

1. Navigate to <Install_Dir>/bin directory.

2. Initialize the environment with the ./splenviron.cmd -e <envname> command.

3. cd %SPLEBASE%\bin.

4. Run deploymapviewer.cmd.

5. Enter WebLogic Domain Console password. For example, weblogic123.

Post-deploying the Custom MapViewer
Perform the following steps after deploying the custom MapViewer:

1. Log into the MapViewer: http://<Server>:<port>/mapviewer.

2. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration. Login to the Mapviewer at this location: http://
<HOST>:<MANAGERPORT>/mapviewer

3. Add the below content in the mapViewerConfig.xml with the appropriate values:

<map_data_source name="MAPCONN"
jdbc_host="<DB server name>"
jdbc_sid="//<DB Service name>"
jdbc_port="1521"
jdbc_user="DWADM"
jdbc_password="!<DWADM user password>" 
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"
/>

Note: The exclamatory mark in the front of the password ensures that the 
password is encrypted. 

4. Click Save, and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Enabling WriteBack
For enabling the WriteBack, perform the following steps:

1.  Log into Analytics and navigate to Administration>Manage 
Privileges>WriteBack>Write Back to Database.

2. Click Denied:Authenticated User and select the permission Granted.

Enabling the Analytics Help
To enable the Analytics’ Help, perform these steps: 

1. Download Oracle Utilities Analytics v2.5.2.0.1 Getting Started Guide from Oracle Software 
Delivery Cloud (https:// edelivery.oracle.com).

2. After downloading Oracle Utilities Analytics v2.5.2.0.1 Getting Started Guide, change the name of 
the OUA_Getting_Started_Guide_2.5.2.0.1.pdf file to OUASA Help.pdf.

3. Place the Help file in <install_dir>/Skin/res, where <install_dir> is the Oracle Utilities 
Analytics Dashboard Package installation directory.
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4. Run the following commands: 

For UNIX:
Perform the following steps: 

a. Navigate to <Install_Dir>/bin directory.

b. Initialize the environment with the ./splenviron.sh -e <envname> command.

c. cd $SPLEBASE/bin.

d. Run ksh ./deployanalyticsear.sh.

e. Enter the WebLogic Domain Console password. For example, weblogic123.

For Windows:

Perform the following steps: 

a. Navigate to <Install_Dir>/bin directory.

b. Initialize the environment with the ./splenviron.cmd -e <envname> command.

c. cd %SPLEBASE%/bin.

d. deployanalyticsear.cmd.

e. Enter the WebLogic Domain Console password. For example, weblogic123.

f. Restart the Oracle Utilities Analytics core services.

g. Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business 
Intelligence Enterprise Edition deployment is completed.

Enabling the Auto Complete Feature on Oracle Business Intelligence 
Enterprise Edition 11.1.1.7.1

To enable auto complete feature on Oracle Business Intelligence Enterprise Edition, perform the 
following steps: 

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server 
and opmn services. 

Note: Refer to Oracle Business Intelligence Enterprise Edition documentation 
for the detailed instructions on how to start, stop admin server, managed server 
and opmn services.

2. Login to analytics (http://<Server>:<port>/analytics).

3. Click on the WebLogic User (top-most-right section of the page). 

4. From the drop-down menu, select My Account. 

5. Set Prompt Auto Complete to ON, and click OK. 
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Chapter 6 
Spatial Configuration

This chapter contains information on how to setup spatial data for the Oracle Business 
Intelligence Enterprise Edition dashboards in Oracle Utilities Analytics and how to set up the 
spatial data. The mapping between the spatial columns and the dimensional columns, such as City, 
State from the Address dimension is defined in the spatial metadata catalog, which is available as a 
part of the Web Catalog component in Oracle Utilities Analytics. Using the spatial data and the 
map metadata, users can view the star schema data in on the map reports delivered out-of-the-box 
as part of Oracle Utilities Analytics.

This chapter has the following sections:

• Acquiring the Spatial Data

• Installing Spatial Data

• Importing the Spatial Data into Oracle Utilities Analytics Spatial Data Tables

• Loading the Oracle Utilities Specific Themes

Acquiring the Spatial Data
Oracle Utilities Analytics does not include any spatial data. The spatial data can be loaded from the 
various third party vendors. Some of the spatial data vendors who partner with Oracle can be 
found in the below Oracle Technology Network page:

http://www.oracle.com/technetwork/database/options/spatialandgraph/community/partners/
spatial-partners-095101.html

Some of these vendors might require you to purchase a separate license for the spatial data. You 
need to get in touch with the vendor directly for the same. After this, you would be able to 
download a spatial data dump from the spatial data vendor.

Installing Spatial Data
The spatial data acquired from a third party vendor can be in various formats. Typical vendors 
provide shape files (.shp) or a database dump for download. The exact spatial data model varies 
from vary to vendor and there is no generic format to this. Hence, the documentation that comes 
along with the spatial data is of utmost importance. This is required to identify what type of spatial 
data is available in which table. 

The first task is to import the data in the shape file into the DWADM schema. A database dump 
can be imported by the standard oracle impdp command. A shape file can also contain the spatial 
data tables along with the data that can be imported by Oracle MapBuilder. Follow the steps 
mentioned below for this:
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1. Unzip or decompress the .zip file (Typically, the shape file is zipped for data compression) to 
a temp directory. For example, C:\Spatial    

2. Download the standalone MapBuilder application from this site: 
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index-
100641.html

3. Start the MapBuilder. On windows, run this to start: java -jar mapbuilder.jar 

Note: Refer to the MapViewer documentation for detailed instructions on 
installing and running MapBuilder from this site: http://www.oracle.com/
technetwork/middleware/mapviewer/documentation/index.html

4. Create a connection to the DWADM schema in the Oracle Utilities Analytics Data 
Warehouse database by navigating to File > New Connection.

5. Navigate to Tools > Import Shapefile, and click Next.

6. Click the Shapefile.

7. Browse to the C:\Spatial directory, select the .shp file, and click Open.

8. Click Next.

9. Ensure the Create Predefined Theme box is unchecked, and click Next.

10. Review the summary information and click Finish. A sample screenshot is shown below.

Importing the Spatial Data into Oracle Utilities Analytics Spatial 
Data Tables

Once the spatial data tables from an third party vendor have been imported into the DWADM 
schema, the next step is to import the spatial data needed by Oracle Utilities Analytics into certain 
specific tables. This step to import a certain subset of the data into a standardized set of Oracle 
Utilities Analytics tables is for decoupling. This decoupling helps the Oracle Business Intelligence 
Enterprise Edition map reports and other Oracle Business Intelligence Enterprise Edition map 
configuration to remain oblivious to the variations in the spatial data schema coming from various 
vendors. This way you need not touch any of the spatial metadata catalog or modify any of the 
map reports being delivered out-of-the-box. 
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Oracle Utilities Analytics needs the administrative boundary type of spatial data at four levels - 
State, City, County and Postal Code. All map reports in Oracle Utilities Analytics are using one of 
these levels. Since the spatial data model varies from vendor to vendor, further details provided in 
this section is based on a sample spatial data from a specific vendor.

The following sections describe how the import the data based on a sample spatial data dump 
provided by HERE maps (formerly NAVTEQ).This sample data set contains administrative 
boundary data for the OHIO city in the US country. The sample data set from the Oracle partner 
can be downloaded from the Oracle Utilities Analytic's OTN (Oracle Technology Network) page:

http://www.oracle.com/technetwork/database/options/spatialandgraph/downloads/spatial-
partners-data-087203.html

However, the steps can be used with a little variation to setup the spatial data for Oracle Utilities 
Analytics for any city from any country. The extent of the changes need to be done varies based 
on the vendor used to purchase the spatial data. Read through the documentation of the spatial 
data model provided by the vendor to understand what type of data lies in what table. 

Below table provides a simple mapping based on the HERE maps sample data.

Spatial 
Data 
Level

Table in Navteq
Sample Data

Additional Filters
Oracle Utilities 
Analytics Spatial 
Data Table

State WOM_AREA Feature Type = 90996

ISO Country Code = 
‘USA’

Q1_STATES54004

City PL39_d00 Q1_CITY54004 lsad_trans = 'city', 
’village'

County CO39_D00   Q1_COUNTY54004

Postal 
Code

ZT39_D00   Q1_USZIP54004

Apart from these four levels, there are also some standard themes and styles that need to be 
imported. 

Below sub-sections contain the SQL statements to create and populate the various spatial data 
tables for Oracle Utilities Analytics. The prerequisite is that spatial data has been purchased by you 
and the spatial data dump has been imported into the DWADM schema. It is assumed that the 
eLocation website is being used as the base map in the Oracle Business Intelligence Enterprise 
Edition mapviewer setup, for which the SRID (Spatial Reference System Identifier) is 54004. The 
SRID is a unique value used to identify the coordinate system used in a Geographic Information 
System (GIS) application. If some other base map is used, then the transform parameter in the 
insert statements should specify the SRID of the base map being used.

Importing Theme Related Spatial Data into Oracle Utilities Analytics
The sdo_ tables are standard tables expected to be present in the spatial data from any vendor.

INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;
Spatial Configuration 6-3 
Oracle Utilities Analytics Installation Guide

http://www.oracle.com/technetwork/database/options/spatialandgraph/downloads/spatial-partners-data-087203.html


Importing State Spatial Data into Oracle Utilities Analytics
In Oracle Utilities Analytics, the table Q1_STATES54004 is used to store the state related 
administrative boundary. Create the table based on the DDL below and insert the values from one 
of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_STATES54004
 (
    feature_id     NUMBER,
    feature_name   VARCHAR2(255),
    area_id        NUMBER,
    name_langcode  VARCHAR2(35),
    feature_type   VARCHAR2(30),
    country_code_3 VARCHAR2(5),
    geometry SDO_GEOMETRY,
    carto_id NUMBER(10,0)
 );

INSERT INTO Q1_STATES54004_SDX
SELECT NULL,  name,  NULL,  lang_code,  feature_type,  
ISO_COUNTRY_CODE,  sdo_cs.transform(geometry, 54004),  carto_id
FROM WOM_AREA WHERE feature_type = 909996 AND iso_country_code = 
'ISO'; 

Note: Customize the table name WOM_AREA, the feature type value and the 
ISO country code as per the spatial data model obtained by you. The below 
insert statement is to define the Q1_ table as a spatial table and update the 
spatial metadata view to reflect the dimensional information for the areas. The 
parameters for the insert statement are table name, geometry column name, 
and X and Y boundaries (the latitude and the longitude) based on the data and 
the tolerance value.

INSERT INTO user_sdo_geom_metadata VALUES
('Q1_STATES54004', 'GEOMETRY', 
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004 );

CREATE INDEX Q1_STATES54004_SDX ON Q1_STATES54004 (geometry)  
indextype IS MDSYS.SPATIAL_INDEX;

Importing City Spatial Data into Oracle Utilities Analytics
In Oracle Utilities Analytics, the table Q1_CITY54004 is used to store the city related 
administrative boundary. Create the table based on the DDL below and insert the values from one 
of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_CITY54004 AS
SELECT upper(name) FEATURE_NAME,  sdo_cs.transform(geometry, 54004) 
geometry,  'OHIO' state FROM pl39_d00 WHERE lsad_trans IN ('city', 
'village');

Note: Customize the table name pl39_d00 and additional filters as per the 
spatial data model obtained by you. Map the state name dynamically for the 
current city record in the spatial data. The below insert statement is to define 
the Q1_ table as a spatial table and update the spatial metadata view to reflect 
the dimensional information for the areas. The parameters for the insert 
statement are table name, geometry column name, and X and Y boundaries 
(the latitude and the longitude) based on the data and the tolerance value.
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INSERT INTO user_sdo_geom_metadata VALUES
('Q1_CITY54004', 'GEOMETRY',  
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)),  54004 );
  
CREATE INDEX Q1_CITY54004_sdx ON Q1_CITY54004  (geometry) indextype 
IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_CITY54004 SET geometry = 
SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Importing County Spatial Data into Oracle Utilities Analytics
In Oracle Utilities Analytics, the table Q1_COUNTY54004 is used to store the county related 
administrative boundary. Create the table based on the DDL below and insert the values from one 
of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_COUNTY54004 AS
SELECT name FEATURE_NAME,  sdo_cs.transform(geometry, 54004) 
geometry, 'OHIO' state FROM CO39_D00;

Note: Customize the table name CO39_D00 as per the available spatial data 
model. The below insert statement is to define the Q1_ table as a spatial table 
and update the spatial metadata view to reflect the dimensional information for 
the areas. The parameters for the insert statement are table name, geometry 
column name, and X and Y boundaries (the latitude and the longitude) based 
on the data and the tolerance value.

INSERT INTO user_sdo_geom_metadata VALUES
('Q1_COUNTY54004', 'GEOMETRY',  
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)),  54004 );

CREATE INDEX Q1_COUNTY54004_sdx ON q1_county54004 (geometry)  
indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_COUNTY54004 SET geometry = 
SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Importing Postal Code Spatial Data into Oracle Utilities Analytics
In Oracle Utilities Analytics, the table Q1_USZIP54004 is used to store the county related 
administrative boundary. Create the table based on the DDL below and insert the values from one 
of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_USZIP54004 AS
SELECT zcta ZCTA5CE, sdo_cs.transform(geometry, 54004) geom. FROM 
ZT39_D00;

Note: Customize the table name ZT39_D00 as per the available spatial data 
model. The below insert statement is to define the Q1_ table as a spatial table 
and update the spatial metadata view to reflect the dimensional information for 
the areas. The parameters for the insert statement are table name, geometry 
column name, and X and Y boundaries (the latitude and the longitude) based 
on the data and the tolerance value.
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INSERT INTO user_sdo_geom_metadata VALUES
('Q1_USZIP54004', 'GEOM',  
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)),  54004 );

CREATE INDEX Q1_USZIP54004_SDX ON Q1_USZIP54004 (geom)  indextype 
IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_USZIP54004 SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, 
.05);

Improving Performance by Prefetching the Map Tiles 
Rendering map tiles dynamically can affect system performance. To avoid this, you may consider 
prefetching tiles by issuing an admin request to MapViewer on a non-production server or when 
the server is not under load. When MapViewer receives a prefetching request, it issues many 
concurrent map tile requests to itself, which are basically XML map requests, and stores them in 
the cache. This improves the system’s performance as the images are readily available.

Follow the following procedure to prefetch map tiles. These instructions are for MapViewer 
11.1.1.7.1 version. If you are using a different version, refer to the MapViewer documentation for 
instructions. 

1. In the MapViewer console, click Admin in the top-right corner of the page and log into the 
Admin Console page.

2. In the Admin Console page, click Management > Manage Map Tile Layers.

3. Select the required online map tile and click View map/Manage Tiles.

The Prefetching wizard opens:
Spatial Configuration 6-6 
Oracle Utilities Analytics Installation Guide



4. Enter the X, Y coordinates of the center of the map, the SRID and zoom level, and click 
Show Map. 

To prefetch map images, enter the latitude and longitude values. You need to know the 
latitude and longitude values of the center of the location in interest. The SRID is a unique 
value used to identify the coordinate system used in a GIS application. 

The X and Y axis used in the following example is for Ohio:

5. When you see the map, turn on the Area Selection tool and select the area on the map for 
which you want to prefetch the tiles.

6. Select one or more zoom-levels for which you want to prefetch the tiles.

Loading the Oracle Utilities Specific Themes
This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities 
Analytics. 

Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in the database and copy the user_sdo.dmp file from ../
BI252/Spatial-Metadata folder to that location.

2. Import the released spatial tables to the target database using the following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=
impdp_user_sdo.log schemas=DWADM
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from database server.

Note: Make sure to change the tablespace_name to tablespace name on which 
DWADM has the quota. If DWADM user have quota on cists_01 tablespace, 
then exclude whole remap_tablespace clause from command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts from the ../BI252/Spatial-Metadata 
folder:

- sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

Additional Setup for Oracle Utilities Outage Analytics
The Outage Analytics product within Oracle Utilities Analytics needs some additional spatial data 
setup. The reason is that Outage Analytics alone uses point information from spatial data for 
plotting outage event related information on maps. This section should be skipped if NMS is not 
one of the source systems for Oracle Utilities Analytics.

The very first step is to replicate the DIAGRAM_OBJECTS table into the Oracle Utilities 
Analytics database. However, a suitable mechanism needs to be built to refresh this table with the 
latest data from Oracle Utilities Network Management System whenever there are changes in the 
source system.
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Once this is done, then after replicating the DIAGRAM_OBJECTS table, the following steps set 
the Oracle Utilities Analytics dashboards up to use the data in this replicated table.

1. Create the required spatial metadata:

INSERT INTO user_sdo_geom_metadata
VALUES ('DIAGRAM_OBJECTS','LL_GEOMETRY', 
MDSYS.SDO_DIM_ARRAY (

SDO_DIM_ELEMENT ('X', -20037508, 20037508, .05), 
SDO_DIM_ELEMENT ('Y', -45884542, 45884542, .05)

), 54004);

2. Ensure that the spatial index is created on the LL_GEOMETRY column. The 
LL_GEOMETRY column by default stores spatial data using SRID 54004, so this works 
without changes with the eLocation base map:

create index Q1_DIAGRAM_OBJECTS_SDX
on diagram_objects (ll_geometry)
indextype is mdsys.spatial_index;

Once DIAGRAM_OBJECTS table is replicated to the Oracle Utilities Analytics database, follow 
the below steps to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to the DWADM schema of Oracle Utilities Analytics database and execute the 
following:

CREATE TABLE Q1_DIAGRAM_OBJECTS_54004 as select * from 
DIAGRAM_OBJECTS;

2. INSERT INTO user_sdo_geom_metadata:

VALUES ('Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY', 
MDSYS.SDO_DIM_ARRAY (

SDO_DIM_ELEMENT ('X', -20037508, 20037508, .05), 
SDO_DIM_ELEMENT ('Y', -45884542, 45884542, .05)

), 54004);

3. CREATE INDEX Q1_DIAGRAM_OBJECTS_SDX_54004 on 
Q1_DIAGRAM_OBJECTS_54004 (ll_geometry) indextype is mdsys.spatial_index;.
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4. Under Tile Operations, click on Prefetch Tiles. Here is a snapshot of the area selection and 
the tile operation.

This process takes some time, depending upon the hardware configuration of the system and the 
amount of data to be prefetched. To check the current status of the operation, click Refresh 
under the Operation Status. The status will change to “Finished” when the operation is done.
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Chapter 7 
Installing the NMS Business Intelligence 

Publisher Reports

This section describes the steps to be performed while installing the Oracle Utilities Analytics 
NMS IEEE outage reports:

1. Unzip the IEEE outage reports contained in OUA NMS BI Publisher reports.zip from the 
installation media to a temporary directory (ex. TEMPDIR) on the server where Oracle BI 
Publiser is installed.

2. Log into Oracle BI Publisher (http://<BI Publisher server name>:9704/xmlpserver/) as the 
Administrator from a browser that has access to the TEMPDIR folder from the step 1. 

3. Set up a database connection as follows:

a. Navigate to Oracle BI Publisher Administration > Data Sources > JDBC 
Connection.

b. Click Add Data Source.

c. In the Data Source Name field, enter NMS BI Publisher or a name of your choice.

d. Set the Driver Type to Oracle 9i/10g/11g. 

e. Set the Database Driver Class to oracle.jdbc.OracleDriver. 

f. Set the Connection string to:jdbc:oracle:thin:@<your machine>:<Port>:<the 
ORACLE_SID> 

g. Set the username and password to match your Oracle Utilities Analytics database login 
values. 

h. Click Test Connection and verify that it is properly configured. 

i. Click Apply. 

4. From the BI Publisher Catalog page, select Shared Folders from the folders tree. 

5. On top of the folders section, click the New drop-down list and select Folder from the list.

6. Enter NMS IEEE Reports as the folder name (or a name of your choice), then click Create. 
The new folder is added. You may have to click Refresh button to update the Folders list.

7. Select the NMS IEEE Reports folder in the folder list.
Under the NMS IEEE Reports folder, create another new folder named NMS IEEE Data 
Models.

8. Select the NMS IEEE Data Models directory, and then click Upload in the Tasks section 
on the bottom left.
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a. Browse to the directory where the NMS IEEE BI Publisher reports exist (TEMPDIR 
from step 1).

b. Locate all of the data model files and upload them to the NMS IEEE Data Models 
directory. These files contain an extension of .xdmz and include the following files:

• CriticalCustomerOutages.xdmz

• DailyTroubleReport.xdmz

• DeviceOutageHistory.xdmz

• IEEEIndiceCalculations.xdmz

• IndicesByCity.xdmz

• OutageSummary.dxmz

• RecurringDeviceOutages.xdmz

• SustainedOutagesByCauseSummary.xdmz

• SustainedOutageSummary.xdmz

9. Select the NMS IEEE Reports directory, and then click Upload in the Tasks section on the 
bottom left

a. Browse to the directory where the OUA NMS IEEE BI Publisher reports exist 
(TEMPDIR from step 1). 

b. Locate all of the report files and upload them to the NMS IEEE Reports directory. 
These files contain an extension of .xdoz and include the following files:

• CriticalCustomerOutages.xdoz

• DailyTroubleReport.xdoz

• DeviceOutageHistory.xdoz

• IEEEIndiceCalculations.xdoz

• IndicesByCity.xdoz

• OutageSummary.xdoz

• RecurringDeviceOutages.xdoz

• SustainedOutagesByCauseSummary.xdoz

• SustainedOutageSummary.xdoz

10. Assign the appropriate JDBC connection to the imported data models.

a. Click Catalog. 

b. Select the NMS IEEE Data Models directory, and then select the 
CriticalCustomerOutages.xdmz data model.

c. Click Data Model on the top left. 

d. In the Properties frame on the right, make sure that Default Data Source points to the 
data source you created earlier. This defaults to NMS BI Publisher.

e. You must perform this step for all of the data models under the NMS IEEE Data 
Models directory.

11. Assign the appropriate data model to all the NMS IEEE Reports.

a. Click on Catalog. 

b. Select the NMS IEEE Reports directory. Click Edit for the 
CriticalCustomerOutages report.
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c. At the top left of the page, click Search.

d. Browse and select the appropriate data model file (will match the name of the report with 
an extension of .xdmz).

e. Save the current report by clicking Save on the top-right of the page.

You should now be able view the standard IEEE indices reports from BI Publisher by simply 
selecting the desired report from the NMS IEEE Reports directory under the Catalog.
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